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1. The eVSM Environment
Help Movies
These and other short movies about using eVSM are
available at www.evsm.com/help
Start Drawing

eVSM Pre-requisites and Updates
eVSM requires Windows 2000/XP/Vista/Win7, Visio 20032010 (32-bit), and Excel 2000-2010 (32-bit). You can check
on the latest eVSM version available at:
www.evsm.com/updates

Starting eVSM

Start eVSM

The best way to start a blank value
stream map is to double-click the
eVSM icon on your desktop.

If your Visio security setting is set to anything but low,
messages will come up asking for permission to “Enable
Macros”. You must answer “Yes” to these messages for
eVSM to operate.
4
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eVSM Toolbar

...

The eVSM toolbar is located just above the drawing page. If
this is not visible then the eVSM software is not properly
installed or the Visio security setting on your system is
preventing running the macros that create the toolbar.
For information on each of the buttons, see the “Toolbar
Button Index” at the back of the user guide.

eVSM Help Site
eVSM Help

The Help button on the toolbar requires an internet connection
and will open up a web browser pointed to the eVSM help site
at www.evsm.com/help.
The help site is tested with Internet Explorer which is the
recommended browser if there are any problems.

eVSM Support
We offer technical support for the latest release of the eVSM
software. Please email us at support@evsm.com.

5
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eVSM Shapes & Stencils
eVSM v5

eVSM has a collection of value stream
mapping shapes that appear in eVSM stencils
to the left of the drawing page.
These shapes, behaviors, and corresponding
functions have been designed from the outset
to support the series of lean workbooks from
the Lean Enterprise Institute (www.lean.org) ,
the Lean Enterprise Academy
(www.leanuk.org) and their worldwide network
partners. The primary workbook impacting the
design has been “Learning To See”.
As software usage has become widespread
across multiple industries, the icon language
has been extended to keep pace with
practitioner requests. For Lean Healthcare
implementations, the software now supports
all publications developed by Lean Healthcare
West (www.leanhealthcarewest.com).

Quick Mfg
Quick Services
Quick Healthcare

6

To make it easier to navigate the
comprehensive set of shapes, they have been
organized into family stacks (blue icons in the
stencil) and into the subset stencils.
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Re-opening eVSM Stencils
eVSM Stencils must always be kept open when working with
maps. If you have “lost” the eVSM stencils from your drawing
file, here are the steps to re-open them.
In Visio 2003/2007:
Click “File > Shapes > Open Stencil…”
Navigate to the following folder:
“C:\Program Files\GumshoeKI\Visio2002\Setup\Solutions”
Select all the eVSMIcons.vss stencil file in this folder and
then click the Open button.
Save your Visio file so it “remembers” this stencil for next
time.
In Visio 2010:
In the Shapes pane (on left) click "More Shapes > Open
Stencil..."
Follow the same steps as above.
Note that on 64-bit Windows, the file location is:
"C:\Program Files(x86)\GumshoeKI\Visio2002\Setup\Solutions"

7
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Page Resizing
To resize the page, hold down the CTRL key and move the
cursor to the edge of the page. The cursor will turn into a
double-headed arrow. Simply grab the edge and pull it to the
required size.

Note: Avoid page corners when re-sizing the page. The page
corners allow rotation of the drawing page. However, there is
a Visio bug which can corrupt the drawing file if the page is
rotated.
If you rotate the page accidentally, use "Edit>Undo" to
recover. In Visio 2010, use the Undo button in the top menu
bar. If it is too late to Undo, then copy/paste the drawing
content to a new page.

8
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Drag & Drop
Outside
Source

Drag and drop eVSM icons from the
stencil onto the drawing page.
Blue icons represent stacks of shapes.
Access the stack by dragging out the
shape and then clicking the right
mouse button.

Process

Snap To Grid

Cross Dock
In_Store Storage
Moment_Of_Truth
Picture Process
Process
Process Cell
Production Control
Rework Process
Shared Process
Warehouse

Shapes are designed to be grid-sized. The drawing page has
a grid on it. Use “View > Grid” to turn grid visibility on. Snap
shapes to grid locations for easy alignment.

Resizing Shapes
Avoid resizing shapes whenever possible. Shapes are
designed to fit together and resizing a shape will make “fitting”
shapes together difficult and create extra work.

9
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Connecting Shapes - Glue
eVSM shapes have built-in connection points on their
boundaries that allow them to be glued together. Gluing
shapes together has two uses:
It makes modifying the map simpler because moving a
parent shape causes the child shape to move with it.
eVSM infers association between shapes by looking at
the parent-child glue connections between shapes.
Process

Process

Process
Name

Value Unit

Process
Name

Value Unit

Visio shows a glue connection at the
point of gluing with a red box. When
the arrow head is moved to a point
where Visio is about to glue it to the
lower process block, a red box is
temporarily displayed.
Similar to connecting arrows, the red
box appears when you move a data
shape to the bottom of an activity
shape.
When a child shape is glued to a
parent and you select the child
shape you will see some red dots on
its periphery to indicate that it is
glued.

eVSM Glue Check On/Off
Toggle the Glue Check button in the toolbar for a visual
display of the glue connections.
10

1. The eVSM Environment

10

Text Editing
Double-click a shape to edit its text.

Manipulating Text
Twice per
week

Double-click a shape to edit its text.
The Visio Text Block Tool (located
behind the Text Tool in the Visio
Standard toolbar) can be used to move
the text relative to the shape location.

Twice per
week

Text Block Tool

The Text Block Tool displays control
handles around the text belonging to a
shape. These control handles can be
used to position and size the text block.

Twice per week

Caution: Be sure to de-select the Text Block Tool when
finished.
All shapes in Visio can have their own text. This includes
eVSM Connector Arrows.

to
Tex
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Copying Shapes
“Edit>Copy” followed by “Edit>Paste” (or Ctrl+C and Ctrl+V)
work in Visio just like any other Windows program.
Another method is to hold the Ctrl key down, and then move
one or more shapes to create duplicates. You must keep the
Ctrl key pressed for this to work. Otherwise you will just end
up moving the original shapes.

Undoing Mistakes
The Visio toolbar has an “Undo” button to reverse any
mistakes (also, “Edit>Undo”)

Visio Pages
Pages can be created, deleted, etc. via the right-mouse menu
on the page tabs.
Insert Page…
Delete Page
Rename Page
Reorder Pages...

Rules for Visio drawing page naming:
Page names must start with an alpha character
Page names must be limited to 0-9 and A-Z characters.
Characters such as [!@#$%^&*()|+-?] are not allowed
Page names should be kept as short as possible
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Zooming In and Out
CTRL-SHIFT-Drag Select region (Zoom into the selected
region).
Try the Visio menu “View > Pan and Zoom” for another
navigation option with a mini-window.
To set up the mouse scroll wheel to zoom, use the Visio
menus: “Tools > Options > General” and check:
Zoom on roll with InteliMouse
Center selection on zoom

Visio 2010 has zoom controls at the bottom-right of the
window.
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DO use a mouse to be productive with eVSM.
DO glue everything and use Glue Check button.
DO Snap shapes to grid locations.
DO zoom in fast with CTRL-SHIFT-Drag.
DO zoom out quickly with CTRL-W.
NOTE: In Visio 2010, use CTRL-SHIFT-W. CTRL-W
will close the page.
DON’T resize eVSM Shapes whenever possible.
DON’T close eVSM Stencils.

14
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2. Quick Manufacturing
What is Quick eVSM ?
Quick eVSM denotes stencils that are built on eVSM to
simplify, standardize, and speed up creation of value stream
maps in an application area. The ‘Quick Mfg’ stencil in eVSM
v5 has been built for VSMs at a plant level.
Watch a movie about using the Quick Mfg stencil.
Download Visio file containing example maps
created with the Quick Mfg stencil.

Quick Mfg Stencil

Macro Shape
A020

1
Type

16
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Queue

xx Day

Auto

Day
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Can Quick eVSM stencils be used on existing maps ?
You can only use the Quick eVSM stencils for completely
NEW maps. The stencils rely on a standard set of names,
units, and eqn’s that old maps will not be compliant to.

Quick eVSM Stencils : Icon Colors
The icons in the Quick eVSM stencils (such as the Quick Mfg
stencil) have the following color conventions:
Red Quick eVSM Icons need to be
placed on EVERY map and should be
the first items placed on the map.
Green Quick eVSM Icons represent
INDEPENDENT macro shapes. Blue
shapes in the icon denote ‘Right Mouse
Button’ options that can change the
shape visual (e.g. from truck to ship).
Yellow Quick eVSM Icons represent
optional add-ons to the macro shapes
in the Green Icons. These icons are
named to correspond to the Green
icons to which they can be added.
Magenta Quick eVSM Icons represent
pre-configured charts that can be
dropped on the page and plotted.
17
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Recommended Layout for Quick eVSM

Note that the main eVSM stencil (typically named eVSM
vX.XX) is on the left of the screen. We will refer to this as the
“Main Stencil”. Its important that this stencil is never closed
because closing it disables eVSM toolbar functions.

18
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Any Quick eVSM stencils (such as Quick Mfg) are docked on
the right of the screen. We will refer to such stencils as the
“Quick Stencil”. Click and drag the Quick Stencil header bar to
move it to this docked position.

19
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Icon Help
Quick eVSM Icons all have associated help text that is visible
if you hold your mouse over the appropriate icon in the stencil.

Drag and Drop Behavior
When you drag and drop an icon on the page it creates either
a single shape or a macro shape (a set of connected
Shapes).
Red, green, and magenta icons are independent and do not
need to be attached to other items when they are being
dropped on the page.
Yellow icons represent add-on shapes. They need to be
positioned and attached to their parent shape as part of the
drag & drop process.

Moving Shapes On The Map
When the macro shapes
corresponding to the green icons
are dragged onto the page, they
include an ‘Anchor Shape’ that is
shaded in light green. To move the
macro shape as a whole, this
anchor shape should be moved. In
the diagram, the truck is the
anchor shape.

20
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Zooming In and Out
CTRL-SHIFT Select region (Zoom into the selected
region)

Page Resizing
When you run out of space on the drawing page, DO NOT
resize eVSM shapes. Instead just make the drawing page
bigger. An easy way to do this in Visio is to hold down the
CTRL key and move the cursor to any edge of the page. The
cursor will turn into a double-headed arrow. Just grab the
edge and pull to required size. Avoid the page corners when
re-sizing the page.

Snap To Grid
Shapes are designed to be grid-sized. Snap shapes to grid
locations for easy alignment.

Resizing Shapes
Avoid resizing shapes whenever possible. Shapes are
designed to fit together and resizing a shape will make “fit”
difficult and create extra work.

Text Editing
Double-click a shape to edit its text.

21
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Tagged and Path Located Shapes
The green icons in the stencil have shapes that are pretagged via an “Operation Tag” and pre-assigned to Path 1 via
the “Path Locater”.
Path Locater
Operation Tag
A010 1

Red dot shows
approximate tag
location

Time
Between

xx Day

Auto Day
Transport Center

When the shape is dragged onto the map its operation tag will
“auto-number” to create a unique tag ID. You can double-click
and change the ID but it MUST be unique on the map and it
MUST be an alphabetic character followed by 3 numerals.
The charts in Quick Mfg are plotted in tag alphabetic
sequence order.
22
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Data Shapes
Quick eVSM data shapes have 3 types of entries:
Shapes with xx in the center
field indicate values that
MUST be entered.

Cycle Time

x.xx

Min

Some shapes have default values
already entered. Override these
when necessary.

Batch Size

1

Item

Cycle Time Per Item

Auto
Auto

Min
Min

Any shapes with ‘Auto’ fields
should be left alone. They will be
automatically calculated.

Activity Takt Time

Most data shapes have a Name, Value, Unit composition. The
exception are the ‘Value Added’ and ‘Non Value Added’
shapes where the name is implied.

Auto Min

Value Added

23

Auto Day

Non Value Added
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Path Locater shapes
Every macro shape that has a Value Added (VA) or Non
Value Added (NVA) data shape also has a ‘Path Locater’
shape that that defaults to Path 1
1

This variable is used to decide if
the VA or NVA time component
contributes to the ‘Lead Time’ and
if the VA component contributes to
the ‘Total Value Added’ in the
“Time Summary”. If a component
is not intended to contribute to the
total, its path locater shape should
be deleted or changed to a
different path number.

Type
Inventory

xx

Item

Auto Day

2
1

Z010

Time Summary
Time Summary

Total Lead
Time
Total Value
Added
Value Added
Percent
Takt Time

Auto

Day

Auto

Min

Auto

%

Auto

Min

Note the ‘Path Locator’ shapes glued to the top of the ‘Time
Summary’ shape. These filters limit the summation calculation
to the path numbers (1 and 2 in this case).
24
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Drawing Your First Map With Quick Mfg Stencil

Manufacturing
Data

Red icons are MANDATORY
on the map and must be the
first things that are dragged
out onto a new map.
Place the ‘MFG Data’ on the
bottom left of the page.
Z020

Customer Center

Customer
Customer
Daily Demand

200

Item

Place the ‘Customer Center’ on the top right of the page and
enter the “Customer Daily Demand” value (let’s say 200 items
per day). Note that multiple customers can exist on a map.

Time Center

Day

Hr

Min

15

60

60

Hr

Min

Sec

Place the ‘Time Center’ on the bottom left of the page and
enter the number of production hours per day for the map as
a whole. Production hours should exclude planned breaks
(let’s say 15 hours per day).
25
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Outside Center
Drag out the ‘Outside Center’ and place it to the top left of the
map.

Z030

1

Outside Center

Outside Source
Activity Lead
Time

x.xx

Day

Inventory Center
Drag out the ‘Inventory Center’ and enter the inventory type
and amount as shown. The flat line at the bottom represents
the ‘Non Value Added’ time associated with the inventory.
Take the end of the ‘Finished Goods’ arrow and connect it to
the top of the Inventory triangle. The red square appears
briefly to indicate a glue connection.

26
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Inventory Center (Cont’d.)

Inventory Center

A010

1

Raw Material
Inventory

300 Item

Auto Day
Optional Inventory Value Shape
The inventory value is an optional data shape that can be
connected to the bottom of the Inventory Center and can be
useful in calculating the value of the inventory.

Inventory Value

27

Single Item
2.1
Value

$

Inventory
Value

$

Auto

2. Quick Manufacturing
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Optional Inventory Demand Shape
The Inventory Demand shape can be added to the Inventory
center. This would impact the calculation of the NVA time
(Non Value Added Time) corresponding to the inventory
center. Without an explicit ‘Inventory Demand’ shape the NVA
time in days is calculated as:
Inventory (Item) / Customer Daily Demand
This calculation is replaced by :
Inventory (Item) / Inventory Daily Demand

Inventory
Daily
Demand

xx Item

Inventory
Demand

Optional Inventory Demand % Shape
An alternative way to specify the demand on an inventory
center is to add the ‘Demand Percent’ of the Customer Daily
Demand that passes through that Inventory.

Inventory
Demand %

Demand
Percent

xx

%

This value is ignored if an “Inventory Daily Demand” shape
exists at the inventory center
28
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Inventory Quantity Specification
The word ‘Item’ refers to a unit of finished goods. Sometimes
the inventory can be made up of a component that is used
multiple times within one unit of finished goods.
Let’s say that 4 gears are used in each Item of finished goods
and we want to represent an inventory of gears. This is done
in 3 steps:
First, click on the ‘Name Unit Manager’ (listed as “Variables”)
in the toolbar and use the dialog to create a new unit called
‘Gear’.
eVSM Name and Unit Manager
Second, go to the main eVSM Stencil and drag out a ‘Unit
Converter’ shape. Use it to show that there are 4 gears for
every finished goods item.

Item
Units Converter

4
Gear

Finally, specify the inventory as the appropriate number of
gears.
Inventory 1200 Gear

29
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Adding Activity Data
Drag out the ‘Activity Center’ and position it as shown. Type in
the data indicated.
Note that some of the data shapes have been reduced to half
height. This is because they contain variables that will be
used for charting later and are automatically calculated. They
are not considered critical for viewing directly and so some
map space is being preserved.

Activity Center

A050

1

Activity

Cycle Time

6

Min

A020

Associates

2

Staff

Final Widgets

Qty Per Cycle

2

Item

Inventory

Cycle Time Per Item

Auto
Auto
Auto

Min
Min
Min

Activity Takt Time
Activity VA Per Item

1

300 Item

Auto Day
Auto Min
30
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Connecting Activities With Arrows
ExpeditedInformationKa
nbanMaterialPushServic
e

Stepped Arrows

1

1

FIFO Arrow
Activity

Finished Goods

Cycle Time x.xx

Min

Cycle Time x.xx

Min

Associates

1

Staff

Associates

1

Staff

Batch Size

1

Item

Batch Size

1

Item

Cycle Time Per Item

Auto
Auto
Auto

Min
Min
Min

Cycle Time Per Item

Auto
Auto
Auto

Min
Min
Min

Activity Takt Time
Activity VA Per Item

Curvable
Arrows

Activity

Auto

Activity Takt Time
Activity VA Per Item

Min

Auto

Min

One of the arrows above should be used to connect activities
together to show the sequence. A Right-Click provides
additional formats to show the type of flow (PUSH in the
above example).

Electronic Info
Flow

31

The red jagged arrow is used
to represent electronic
information flow (for example,
an email of a forecast from a
customer).
2. Quick Manufacturing
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Optional Activity Center Data Shapes
Optional data shapes that can be added to the bottom of the
activity center are shown on the right. The shapes do NOT
need to be added to all activities, only to those where they
may have significant impact on the value stream.
A010

1

Activity

Cycle Time

x.xx

Min

Associates

1

Staff

Batch Size

1

Item

Cycle Time Per Item

Auto
Auto

Min
Min

Auto
Auto
Auto

Min
Hr
Min

300

Item

10

%

Auto

Min

Activity Takt Time
Assoc. Time Per Item
Daily Associate Time
Activity VA Per Item

Activity Daily
Demand
Downtime
Percent

Activity Demand

Downtime Loss Per
Item

Downtime

VA shape moved down to
accommodate optional
data shapes.
32
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Optional Activity Center Data Shapes (Cont’d.)

Activity Assc
Time

Add this shape to denote the work time
per associate for one cycle of this
activity. The default value is the cycle
time.
Add this shape to denote the time
taken for changeovers each day.

Activity
Changeover

Activity
Scrap

Activity
Demand

Add this shape to denote percent of
Items that are defective from this
activity.

Add this shape to denote a unique
activity demand (due to servicing
multiple value streams, perhaps).

Add this shape to denote the percent of
demand going through this activity.
Activity
Demand %

Activity Downtime
33

Add this shape to record unplanned
downtime. Effect will be to reduce the
‘Cycle Time Per Item’.
2. Quick Manufacturing
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Optional Activity Center Data Shapes (Cont’d.)

Activity NVA

Add this shape to denote the NVA
component within the ‘Cycle Time’ for
an activity.

Activity OEE

OEE can be a general way to denote
all the reasons that a loss in production
occurs.

Activity Shortage

Add this shape to denote percent of
times a shortage in components stops
production at this activity.

Activity Stations

Activity Time

Inventory Rolling
Defects
34

Add this shape to denote multiple
stations. Effect will be to reduce the
‘Cycle Time Per Item’. Note that the
“Associates” value on the ‘Activity
Center’ denotes the total number of
associates at all ‘Activity Stations’
Add this shape to denote a unique
activity available time (due to overtime,
perhaps).

Add this shape to support rolling defect
calculations (See the Rolling Defects
Section).

2. Quick Manufacturing
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Indicating Transportation or Transmit Method

Transport Center

Transmit Center

A010 1

Time
Between

A020 1

xx Day

Auto Day

Time
Between

xx Day

Auto Day

Delete the ‘Path Locater’ and the NVA data blocks if the NVA
time does not participate in the lead time calculation.
Right-click on the transport or transmit icons to select another
type from the family.
Transport has a “Transport Time” add-on shape. Both the
‘Time Between’ and the ‘Transport Time’ are part of the NVA.
If both are present than they are added together.
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Rolling Defects
The rolling defects calculation is an optional add-on shape
that shows the cumulative effect of defects downstream of the
activity and how it impacts capacity at the activity. It must be
used in conjunction with the ‘Activity Defect %’.
Every Green macro shape has its own ‘Rolling Defect’ add-on
shape. In order for the map to calculate the rolling defect,
every shape downstream of the activity must have the ‘Rolling
Defect’ add-on. Also, all centers must be sequenced in order
using the ‘Tag Seq Arrow’ (See the ‘Tag Sequence Arrow’
section in the “Analyzing with eVSM” chapter).
Rolling Defect
Percent

Auto

%

Inventory Rolling
Defects

Activity Rolling
Defects

Rolling Defect Percent

Auto

%

DownStr Loss Per Item
Daily Associate Defect
Time

Auto

Min

Auto

Hr

Rolling Defect
Percent

Auto

%

Wait Rolling
Defects

Note that with the ‘Rolling Defects’ add-on, all the data boxes
will be automatically calculated.
36
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A030

1

Tag Seq Arrow

Stamping

A020

1

Coils
Inventory

2

Item

Rolling Defect
Percent

24.20

%

Cycle Time

3.5

Min

Associates

1

Staff

Batch Size

1

Item

Cycle Time Per Item

3.50

Min

Activity Takt Time

4.08
3.50
14.58
3.50

Min
Min
Hr
Min

Defects
Percent

8

%

Defects Loss Per Item

0.30

Min

Rolling Defect Percent

24.20

%

DownStr Loss Per Item
Daily Associate Defect
Time

0.81

Min

3.53

Hr

Assoc. Time Per Item
Daily Associate Time
Activity VA Per Item

Activity Defects

Activity Rolling
Defects

3.50 Min

After defining the percentage of defects for each activity, the
‘Rolling Defects Percent’ is calculated based on the ‘Defect
Percent’ for activities downstream. Adding a CT / TT chart to
the map will visually show the losses due to defects (see
following example).

37
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Rolling Defects Cont’d

The CT / TT chart is an effective way to visually communicate
how downstream losses due to defects can adversely effect
capacity at upstream activities.

38
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Activity Associate Time
Assoc. Time
Per Cycle
Daily Time Per Associate
Daily Available Time Per
Associate

Activity Assc
Time

x.xx

Min

Auto

Hr

Auto

Hr

The ‘Activity Associate Time’ add-on can be used when an
associate does not spend all their available working time on
the activity.
Enter the amount of time EACH associate spends on the
activity for ONE cycle in the ‘Assoc. Time Per Cycle’ field.
Note that this must be less than the cycle time. The ‘Daily
Time Per Associate’ field is the total amount of time each
associate spends working on the activity in one working day
(and is automatically calculated).
The Staff Summary (following section) summarizes the data
from this and the ‘Rolling Defects’ add on.
The ‘Assoc. Load Chart’ presents the data in a bar graph.
Note that the current capability does not provide a chart that
properly represents available time of associates working on
multiple activities.

Assoc. Load
Chart

Hr

Daily Associate Load Chart
Daily Available
Time Per
Associate
Daily Time Per
Associate

39
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Staff Summary

Staff Summary

Z050

1

Staff Summary
Total Assoc.
Time Per Item
Total Daily
Assoc Time
Total Daily Assoc
Defect Time

Auto

Min

Auto

Hr

Auto

Hr

The Staff Summary gives totals from the ‘Activity Assc Time’
and the ‘Activity Rolling Defects’ add on shapes.
‘Total Assoc. Time Per Item’ gives the total time spent by all
associates in making an item (not necessarily the total cycle
times, if an associate spent less than ‘Cycle Time’ on an
activity).
‘Total Daily Assoc Time’ is the above multiplied by ‘Customer
Daily Demand’.
And ‘Total Daily Assoc Defect Time’ is tied to the “Rolling
Defects’ add-on and sums up all the time lost by associates
due to defects in a day.

40
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Time Summary
Z040

1

Time Summary
Total Lead
Time
Total Value
Added
Value Added
Percent

Time Summary

Takt Time

Auto

Day

Auto

Min

Auto

%

Auto

Min

Drag & drop to the bottom right of the page and just to the
right of the VA/NVA timeline.

Calculating the “Auto” Variables
Once you have entered data in all the input fields, make sure
that all the light green shapes are tagged (See the ‘Tagging
Shapes’ section earlier in this chapter).

Click the “Q” button in the toolbar to execute the built-in
equations. This will create values in all the “Auto” fields.
Quick eVSM
Whenever data is changed on the map, this button should be
clicked to update the map.
41
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Cycle Time / Takt Time Chart
Edit Chart DataPlot ChartCreate
Spreadsheet

CT / TT Chart

Drag & Drop the chart on the page and then Right-Click for
the ‘Plot Chart’ option. It can be filtered by path number by
gluing on a ‘Path Filter’ shape to the bottom right of the chart
shape.
Cycle Time / Takt Time Chart
1.8
1.6
Activity Takt Time

1.4

Shortage Loss Per
Item
OEE Loss per
Item
Scrap Loss Per
Item
Downtime Loss
Per Item
Changeover Loss
Per Item
Cycle Time Per
Item

Min

1.2
1
0.8
0.6
0.4
0.2
0
A040

Sh
ar
pe
n
As
se
m
bl
e

A020
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VA Time / Takt Time Chart

VA / TT Chart

This is very similar to the Cycle Time / Takt Time Chart. Use it
if you have applied the “Activity NVA” add-on to any of your
‘Activity Centers’. It splits the cycle time into its VA and NVA
components.

NVA Timeline Chart

NVA Timeline
Chart

This chart plots the NVA times in a horizontal bar chart and
“to scale”. It can be filtered by Path Number.
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Quick Mfg Info

Quick Mfg Info

This shape contains an image that lays out the content of the
Quick Mfg stencil on a single page and provides annotation
on the equations that are involved in calculating all the “Auto”
fields.
Drag out the shape for Preview or Printing.

Quick eVSM Summary
Quick eVSM stencils provide a standard, easy, and rapid
means of creating, analyzing, and visualizing the map.
The Quick Mfg stencil in eVSM V5 provides a highly
productive way of working with plant-level value stream maps.
The eVSM group plans to create further “Quick” stencils in
respond to customer demand. If you have such a request
please email us at support@evsm.com.
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3. Quick Services
What is Quick eVSM ?
Quick eVSM denotes stencils that are built on eVSM to
simplify, standardize, and speed up the creation of value
stream maps in an application area. The ‘Quick Services’
stencil in eVSM has been built for VSMs at a product level.

Help Movie
Short movies about using eVSM are available at
www.evsm.com/help.

Quick
Services

Quick Services
Stencil

Icon

Macro Shape
A040
1

Decision

46
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YES

x.xx

%

NO

x.xx

%
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Can Quick eVSM stencils be used on existing maps ?
You can only use the Quick eVSM stencils for completely
NEW maps. The stencils rely on a standard set of names,
units, and eqn’s that old maps will not be compliant to.

Quick eVSM Stencils : Icon Colors
The icons in the Quick eVSM stencils (such as the Quick
Services stencil) have the following color conventions:
Red Quick eVSM Icons need to be
placed on EVERY map and should be
the first items placed on the map.
Green Quick eVSM Icons represent
INDEPENDENT macro shapes. Blue
shapes in the icon denote ‘Right Mouse
Button’ options that can change the
shape visual (e.g. from truck to ship).
Yellow Quick eVSM Icons represent
optional add-ons to the macro shapes
in the Green Icons. These icons are
named to correspond to the Green
icons to which they can be added.
Magenta Quick HC Icons represent
pre-configured charts that can be
dropped on the page and plotted.
47

3. Quick Services

47

Recommended Layout for Quick eVSM

Note that the main eVSM stencil (typically named eVSM
vX.XX) is on the left side of the screen. We will refer to this as
the “Main Stencil”. It’s important that this stencil is never
closed because closing it disables eVSM toolbar functions.
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Any Quick eVSM stencils (such as Quick Services) are
docked on the right of the screen. We will refer to such
stencils as the “Quick Stencil”. Click and drag the Quick
Stencil header bar to move it to this docked position.
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Icon Help
Quick eVSM Icons all have associated help text that is visible
if you hold your mouse over the appropriate icon in the stencil.

Drag and Drop Behavior
When you drag and drop an icon on the page it creates either
a single shape or a macro shape (a set of connected
Shapes).
Red, green, and magenta icons are independent and do not
need to be attached to other items when they are being
dropped on the page.
Yellow icons represent add-on shapes. They need to be
positioned and attached to their parent shape as part of the
drag & drop process.

Moving Shapes On The Map
When the macro shapes
corresponding to the green icons
are dragged onto the page, they
include an ‘Anchor Shape’ that is
shaded in light green. To move the
macro shape as a whole, this
anchor shape should be moved. In
this example, the fax icon is the
anchor shape.

50

3. Quick Services

A040 1

Transmit
Time

xx Min

Auto Min
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Zooming In and Out
CTRL-SHIFT-Drag Select region (Zoom into the selected
region).

Page Resizing
When you run out of space on the drawing page, DO NOT
resize eVSM shapes. Instead just make the drawing page
bigger. An easy way to do this in Visio is to hold down the
CTRL key and move the cursor to any edge of the page. The
cursor will turn into a double-headed arrow. Just grab the
edge and pull to the required size. Avoid the page corners
when re-sizing the page.

Snap To Grid
Shapes are sized to fit the grid. Snap shapes to grid locations
for easy alignment.

Resizing Shapes
Avoid resizing shapes whenever possible. Shapes are
designed to fit together and resizing a shape will make “fit”
difficult and create extra work.

Text Editing
Double-click a shape to edit its text.
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Tagged and Path Located Shapes
The green icons in the stencil have shapes that are pretagged with an “Operation Tag” and pre-assigned to Path 1
via the “Path Locater”.
Path Locater

Operation Tag

A040 1

Red dot shows
approximate tag
location

Transmit
Time

xx Min

Auto Min
Transmit Center

When the shape is dragged onto the map its operation tag will
“auto-number” to create a unique tag ID. You can double-click
and change the ID but it MUST be unique on the map and it
MUST be an alphabetic character followed by 3 numerals.
The charts in eVSM are plotted in tag alphabetic sequence
order.
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Data Shapes
Quick eVSM data shapes have 3 types of entries:
Shapes with xx in the center
field indicate values that
MUST be entered.

Cycle Time

x.xx

Min

Some shapes have default values
already entered. Override these
when necessary.

Batch Size

1

Item

Cycle Time Per Doc

Auto
Auto

Min
Min

Any shapes with ‘Auto’ fields
should be left alone. They will be
automatically calculated.

Activity Takt Time

Most data shapes have a Name, Value, Unit composition. The
exception are the ‘Value Added’ and ‘Non Value Added’
shapes where the name is implied.

Auto Min

Value Added

53

Auto Day

Non Value Added
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Path Locater shapes
Every macro shape that can have a Value Added (VA) or Non
Value Added (NVA) time also has a ‘Path Locater’ shape that
that defaults to Path 1.
This variable is used to decide if
the VA or NVA time component
contributes to the ‘Lead Time’ and
if the VA component contributes to
the ‘Total Value Added’ in the
“Time Summary”. If a component
is not intended to contribute to the
totals its path locater shape should
be deleted or changed to a
different path number.

A080

1

Type
Queue
Queue Loss

xx Doc
Auto

Min

Auto Min

Time Summary

Z350

1

Time Summary
Lead Time
Total Value
Added
Value Added
Percent
Takt Time
54

Auto

Hr

Auto

Min

Auto

%

Auto

Min

The ‘Path Locator’ shape
filters the summation to
the path number (1 in this
case).
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Your First Map With Quick Services Stencil

Services Data

SVC
DATA

Red icons are MANDATORY
and must be placed on the
map first before drawing a
new map.
Place the ‘Services Data’ icon
on the bottom left of the page.

Z020

1

Customer Center

Drop the ‘Customer Center’ on
the page, name the customer,
and enter the “Daily Documents”
value. Note that multiple
customers can exist on a map.

Time Center

Customer
Daily
Documents

xx

Doc

Day

Hr

Min

xx

60

60

Hr

Min

Sec

Drop the ‘Time Center’ on the page and enter the number of
work hours per day for the map as a whole. Work hours
should exclude planned breaks (let’s say 7 hours per day).
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Outside Center
Drag out the ‘Outside Center’ and name it. It is used to
represent suppliers, contractors, vendors, distributers, etc.
Z010

1

Outside Center

Outside Source

If an outside source needs to be included in the calculations,
then use the Activity Center macro shape instead.

Queue Center
Used to represent the number of docs in the in-tray or waiting
ahead of the next activity.
A090

1

Type
Queue
Queue Center

Queue Loss

xx Doc
Auto

Min

Auto Min
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Optional Queue Center Add-ons
Demand
x.xx %
Percent
Queue Demand
%

Optional calculation to show demand as a percentage of total
demand going through Queue Center.

Queue Daily
Demand

xx Doc

Queue Demand

Optional calculation to show volume as an absolute value
going through Queue Center.

Rolling Time Auto

Min

Queue Rolling
Time

Optional calculation to show total time taken to reach this
point in the value stream. Note that all preceding activities
must also have a rolling calculation add-on and the “Tag Seq
Arrow” used to specify the sequence.
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Wait Center
Used to represent the wait time ahead of an activity or a
decision.

A060

Wait Center

1

Type
Enter
description
here

Wait

xx Min

Auto Min

Optional Wait Center Add-on
Rolling Time Auto

Min

Wait Rolling Time

Optional calculation to show total time taken to reach this
point in the value stream. Note that all preceding activities
must also have a rolling calculation add-on and the “Tag Seq
Arrow” used to specify the sequence.
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Decision Center
A070
1

Decision

Decision Center

The Decision Center is used to
represent a decision point. You
need to phrase the decision
description so the answer is
always “Yes” or “No”. If the
decision takes a significant
amount of time, then the time
value should be included in the
preceding activity.

YES

x.xx

%

NO

x.xx

%

Rolling Time

Auto

Min

Optional Decision Center Add-on

Decision Rolling
Time

Optional calculation to show total time taken to reach this
point in the value stream. Note that all preceding activities
must also have a rolling calculation add-on and the “Tag Seq
Arrow” used to specify the sequence.
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Activity Center

A010

1

Activity
Activity Center

Used to represent actual
activities (eg. Enter order,
Schedule, Review, etc.) in the
value stream.
Align the Activity Center to the
grid and with any preceding
macro shapes so that the VA/
NVA shapes at the bottom form
a contiguous time line.

Cycle Time

x.xx

Min

Associates

1

Staff

Batch Size

1

Doc

Cycle Time Per Doc

Daily Associate Time

Auto
Auto
Auto
Auto

Min
Min
Min
Hr

Activity VA Per Doc

Auto

Min

Activity Takt Time
Assoc. Time Per Doc

Enter the description and the
mandatory Cycle Time.

Auto Min

Optional Activity Center Add-ons
Assoc. Time
Per Cycle
Activity Assc
Time

Daily Time Per Associate
Daily Available Time Per
Associate

x.xx

Min

Auto

Hr

Auto

Hr

Add this macro to denote the work time per associate for one
cycle of this activity.
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Optional Activity Center Add-ons (Cont’d)

Activity Defects

Defects
Percent

x.xx

%

Defects Loss Per Doc

Auto

Min

Activity Center Add-On : Add this shape to denote percent of
units that are defective from this activity, if significant
Activity Daily
Demand

xx

Doc

Activity Demand

Add this macro to denote a unique activity demand (due to
servicing multiple value streams, perhaps).

Demand
Percent

x.xx

%

Activity Demand %

Add this macro to denote the percent of demand going
through this activity.

Activity
Downtime

Downtime
Percent

x.xx

%

Downtime Loss Per Doc

Auto

Min

Add this macro to record unplanned downtime. Effect will be
to reduce the ‘Cycle Time Per Item’.
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Optional Activity Center Add-ons (Cont’d)
Activity NVA

xx

Min

Activity NVA Per Doc

Auto

Min

Activity NVA

Auto Min
Add this macro to denote the NVA component within the
Cycle Time for an activity, if significant.
Rolling Time

Auto

Min

Activity Rolling Time

Optional calculation to show the total time taken to reach this
point in the value stream. Note that all preceding activities
must also have a rolling calculation add-on and the “Tag Seq
Arrow” used to specify the sequence.
Stations

1

Stn

Activity Stations

Add this macro to denote multiple stations that each have this
capability. Effect will be to reduce the Cycle Time Per Unit.
Activity Time
Per Day

x.xx

Hr

Activity Time

Add this shape to denote a unique activity available time (due
to overtime, part-time work, etc).
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Query Center
A030

1

Query Type
Query Center

The Query Center allows you to
model any significant loss of lead
time or associate time due to
incorrect, incomplete, or defective
documents.

Query
Percent
Time Per
Query
Assoc. Time
Per Query
Query Loss
Assoc. Time Loss
Daily Associate
Query Time

xx

%

xx Min
xx Min
Auto
Auto
Auto

Min
Min
Hr

Auto Min

Optional Query Center Add-on
Rolling Time Auto

Min

Query Rolling
Time

Optional calculation to show total time taken to reach this
point in the value stream. Note that all preceding activities
must also have a rolling calculation add-on and the “Tag Seq
Arrow” used to specify the sequence.
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Transmit Center
A050 1
Transmit Center

Used when information transmit
time is significant and needs to be
included in the Lead Time
calculation. If time is not important,
then use the Transmit Shapes
from the main stencil instead.

Transmit
Time

xx Min

Auto Min

Optional Transmit Center Add-on
Rolling Time Auto

Min

Transmit Rolling
Time

Optional calculation to show total time taken to reach this
point in the value stream. Note that all preceding activities
must also have a rolling calculation add-on and the “Tag Seq
Arrow” used to specify the sequence.
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Time Summary
Z350

1

Time Summary
Time Summary

Drag & drop to the bottom right
of the page and just to the right
of the VA/NVA timeline.
Note that the Path Locator (1) is
used to filter the summation for
‘Lead Time’ and ‘Total Value
Added’ time.

Lead Time
Total Value
Added
Value Added
Percent
Takt Time

Auto

Hr

Auto

Min

Auto

%

Auto

Min

Staff Summary
Z240

1

Staff Summary
Staff Summary

Drag & drop anywhere on the
map to show the staff totals.

65

Total Assoc.
Time Per Doc
Total Daily
Assoc Time
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Auto

Min

Auto

Hr
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Lane B

Lane A

Swimlane Frame

Lane C

Swimlane Frame

Drag & Drop on the page, and name the swimlanes. Use
right-mouse menus to add/delete rows and to re-size. For
details on drawing value stream maps in swimlanes, see the
eVSM Table function help.

Cycle Time / Takt Time Chart
CT / TT
Chart

Drag & Drop the chart on the page
and then Right-Click for the ‘Plot
Chart’ option. It can be filtered by
path number by gluing on a ‘Path
Filter’ shape to the bottom right of
the chart shape

Cycle Time / Takt Time Chart
25

20

15

Min

CT / TT Chart

Edit Chart DataPlot ChartCreate
Spreadsheet

10

5

0
A310
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Lead Time Chart
Lead
Time
Lead Time Chart

Edit Ladder Chart DataPlot
Ladder ChartCreate
Spreadsheet

Drag & Drop the chart on the page and then Right-Click for
the ‘Plot Chart’ option. It can be filtered by path number by
gluing on a ‘Path Filter’ shape to the bottom right of the chart
shape.
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Key Creator

Key Creator

Adding this Shape to a map will give
you a summary of all the icons used on
the map.

Variables Key Creator

Var Key Creator

Adding this Shape to a map will give
you a summary of all the variables
used on the map.

Quick Services Info

Quick Svc Info

This shape contains an image that lays
out the content of the Quick HC stencil
on a single page and provides
annotation on the equations that are
involved in calculating all the “Auto”
fields.
Drag out the shape for Preview or
Printing.
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4. Quick Healthcare
What is Quick eVSM ?
Quick xx denotes Quick eVSM stencils that are built on eVSM
to simplify, standardize, and speed up creation of value
stream maps in an application area. This chapter talks about
the Quick Healthcare (Quick HC) stencil.

Help Movie
Short movies about using eVSM are available at
www.evsm.com/help.

Quick HC

Quick Healthcare
Stencil

Icon

Macro Shape
A020
1

Decision
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YES

x.xx

%

NO

x.xx

%
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Can Quick eVSM stencils be used on existing maps ?
You can only use the Quick eVSM stencils for completely
NEW maps. The stencils rely on a standard set of names,
units, and eqn’s that old maps will not be compliant to.

Quick eVSM Stencils : Icon Colors
The icons in the Quick HC stencil have the following color
conventions:
Both Red Quick HC Icons need to be
placed on EVERY map and should be
the first items placed on the map.
One of the Red Bar Icons must be
placed on EVERY map. It represents
demand and is assigned the unit PID
(for Patient, Item, or Document) which
must not be changed.
Green Quick HC Icons represent
INDEPENDENT macro shapes.

Yellow Quick HC Icons represent
optional add-ons to the macro shapes
in the Green Icons.
Magenta Quick HC Icons represent
pre-configured charts that can be
dropped on the page and plotted.
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Recommended Layout for Quick eVSM

Note that the main eVSM stencil (typically named eVSM
vX.XX) is on the left of the screen. We will refer to this as the
“Main Stencil”. It’s important that this stencil is never closed
because closing it disables eVSM toolbar functions.
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Any Quick eVSM stencils (such as Quick Healthcare) are
docked on the right of the screen. We will refer to such
stencils as the “Quick Stencil”. Click and drag the Quick
Stencil header bar to move it to this docked position.
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Icon Help
Quick eVSM Icons all have associated help text that is visible
if you hold your mouse over the appropriate icon in the stencil.

Drag and Drop Behavior
When you drag and drop an icon on the page it creates either
a single shape or a macro shape (a set of connected
Shapes).
Red, green, and magenta icons are independent and do not
need to be attached to other items when they are being
dropped on the page.
Yellow icons represent add-on shapes. They need to be
positioned, attached, and glued to their parent shape as part
of the drag & drop process.

Moving Shapes On The Map
When the macro shapes
corresponding to the green icons
are dragged onto the page, they
include an ‘Anchor Shape’ that is
shaded in light green. To move the
macro shape as a whole, this
anchor shape should be moved. In
the diagram, the truck is the
anchor shape.
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Zooming In and Out
CTRL-SHIFT-Drag Select region (Zoom into the selected
region)

Page Resizing
When you run out of space on the drawing page, DO NOT
resize eVSM shapes. Instead just make the drawing page
bigger. An easy way to do this in Visio is to hold down the
CTRL key and move the cursor to any edge of the page. The
cursor will turn into a double-headed arrow. Just grab the
edge and pull to required size. Avoid the page corners when
re-sizing the page.

Snap To Grid
Shapes are designed to be grid-sized. Snap shapes to grid
locations for easy alignment.

Resizing Shapes
Avoid resizing shapes whenever possible. Shapes are
designed to fit together and resizing a shape will make “fit”
difficult and create extra work. You may also run into the risk
of ungluing shapes.

Text Editing
Double-click a shape to edit its text.

75

4. Quick Healthcare

75

Tagged and Path Located Shapes
The green icons in the stencil have shapes that are pretagged via an “Operation Tag” and pre-assigned to Path 1 via
the “Path Locater”.
Path Locater
Operation Tag
A010 1

Red dot shows
approximate tag
location

Time
Between

xx Day

Auto Day
Transport Center

When the shape is dragged onto the map its operation tag will
“auto-number” to create a unique tag ID. You can double-click
and change the ID but it MUST be unique on the map and it
MUST be an alphabetic character followed by 3 numerals.
The charts in Quick HC are plotted in tag alphabetic sequence
order.
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Data Shapes
Quick HC data shapes have 3 types of entries:
Shapes with xx in the center
field indicate values that
MUST be entered.

Cycle Time

x.xx

Min

Some shapes have default values
already entered. Override these
when necessary.

Group Size

1

PID

Cycle Time Per PID

Auto
Auto

Min
Min

Any shapes with ‘Auto’ fields
should be left alone. They will be
automatically calculated.

Activity Takt Time

Most data shapes have a Name, Value, Unit composition. The
exception are the ‘Value Added’ and ‘Non Value Added’
shapes where the name is implied.

Auto Min

Value Added

77

Auto Day

Non Value Added
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Drawing Your First Map With Quick Healthcare
Stencil

Healthcare
Data

Red icons are MANDATORY
on the map and must be the
first things that are dragged
out onto a new map.
Place the ‘Name Unit Eqns’
on the bottom left of the page.

Time Center

Day

Hr

Min

15

60

60

Hr

Min

Sec

Place the ‘Time Center’ anywhere on the page and enter the
number of work hours per day for the map as a whole. Work
hours should exclude planned breaks.
Z120

1

ED Patient
Patient Center
Daily Patients

150

PID

Place the ‘Patient (or Document or Item) Center’ anywhere on
the page and enter the “Daily XX” value (let’s say 200 PID per
day). This represents demand for Takt Time calculations.
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Wait Center
Typically most maps start with a wait for the Patient, Item, or
Document (PID) being processed. So drag out the ‘Wait
Center’ and enter the wait type and time as shown. The flat
line at the bottom represents the ‘Non Value Added’ time
associated with the wait. You can also change the time units
when appropriate: just double click on the units, a dialog pops
up, select the unit you want and double click it. Use the ‘Wait
Center’ anytime there is a wait between activities.

A030

1

Waiting Room
Wait

30 Min

Wait Center
Auto

Min

Optional Wait Shapes
The Wait Range is an optional data shape that can be
connected to the bottom of the Wait center and that can be
used to indicate the range of wait times. However, only the
‘Wait’ variable is used for calculating lead time.

Wait Range

79

Min Wait
Time

5

Min

Max Wait
Time

30

Min
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Queue Center
An alternative way to calculate waiting time is through the
Queue Center shape. You can directly observe the number of
PID’s in a Queue (eg., the number of people in a waiting room
or the number of documents in the IN tray), and enter the
value (you must NOT change the PID units though). The ‘Non
Value Added’ time will automatically be calculated as ‘Queue
Loss’ (queue/demand).

A010

1

Waiting Room
Queue
Queue Center

Queue Loss

Auto

10 PID
Auto Min

Min

Optional Queue Shapes

Queue Demand

Add this shape to denote a unique
queue demand (due to servicing
multiple value streams, perhaps).
Add this shape to denote the demand
percent going through this queue.

Queue Demand
%
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Adding an Activity
Next drag out the ‘Activity Center’ and position it as shown.
Type in the data indicated (‘Group Size’ is the number of
patients that can be processed in one cycle).
Note that some of the data shapes have been reduced to half
height. This is because they contain variables that will be
used for calculation or charting later and are automatically
calculated. They are not considered critical for viewing directly
so some map space is being preserved.

A010

1

Activity Center

Registration

A020

1

Waiting Room
Wait

30 Min

Cycle Time

15

Min

Group Size

1

PID

Cycle Time Per PID

Auto

Min

Activity Takt Time

Auto

Min

Activity VA Per PID

Auto

Min

Auto Min
Auto Min
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Optional Activity Center Shapes
Optional data shapes that can be added to the bottom of the
activity center are shown below. The shapes do NOT need to
be added to all activities, only to those where they may have
significant impact on the value stream.
A070

1

Registration

Activity Demand

Cycle Time

15

Min

Group Size

1

PID

Cycle Time Per PID
Activity Takt Time

Auto
Auto

Min
Min

Activity VA Per PID

Auto

Min

Activity Daily
Demand

200

PID

Stations

5

Stn

Activity Stations

(Denotes multiple stations performing this activity. Will reduce
CT.)
VA shape moved down to
accommodate optional
data shapes.
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Optional Activity Center Data Shapes (Cont’d.)

Add this shape to denote the range of
cycle times.
Activity CT Range

Activity Demand

Add this shape to denote a unique
activity demand (due to servicing
multiple value streams, perhaps).

Add this shape to denote the percent of
demand going through this activity.
Activity Demand
%

Activity Efficiency

Activity Rolling
Time

Activity Time
83

Add this shape to represent loss of
capacity due to reasons such as
interruptions, searches, etc.

Add this shape to calculate time up to
this point. Requires sequence arrows
for calculation (See Rolling Time
Section).
Add this shape to denote a unique
activity available time (for example, due
to a Doctor being required, etc).
4. Quick Healthcare
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Connecting Activities With Arrows

1

A050

1

A065

Activity

Activity

Cycle Time x.xx

Min

Cycle Time x.xx

Min

Group Size

1

PID

Group Size

1

PID

Cycle Time Per PID

Auto
Auto
Auto

Min
Min
Min

Cycle Time Per PID

Auto
Auto
Auto

Min
Min
Min

Activity Takt Time
Activity VA Per PID

Activity Takt Time
Activity VA Per PID

Tag Seq Arrow
Auto

Auto

Min

Min

The ‘Tag Seq Arrow’ from the Main eVSM stencil should be
used to connect activities together to show the sequence (see
Tag Sequence Arrow Section in “Analyzing with eVSM”
Chapter).
The red jagged arrow is used
to represent electronic
information flow (for example,
Electronic Info
an electronic request for an XFlow
Ray).

Transmit Shapes

84

The Blue Transmit Icon allows
you to select the method of
information flow. Right click
the icon to select.
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Query Center
When you do NOT have First Time Correct and Complete
Information, use the Query Center to capture waste due to
resolving incomplete or incorrect information.
Drag out the Query Center Shape and place it between the 2
activities where the query occurs. Use a double-headed
dashed arrow to indicate a query transaction.

A020

Query Center

1

Insurance
Query
20 %
Percent
Time Per
30 Min
Query
Query
Auto Min
Loss

A030

A080
2
1

2

Admit
Patient

Admit ?
YES

25

%

Cycle Time

30

Min

NO

75

%

Group Size

1

PID

Cycle Time Per PID

Auto
Auto
Auto

Min
Min
Min

25

%

Activity Takt Time
Activity VA Per PID

Demand
Percent

Auto

Min
Auto
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Time to make a Decision
Drag out the Decision block and place it after an activity. This
block does not add to process time, but allows for a PID to
move to different activities (for example, whether a patient
needs admitting or not). Estimate how often this decision is
true or not, as a percentage, and fill in the data as shown.
A010
1

Admit ?

Decision Center

YES

25

%

NO

75

%

You will need to add a second Path Number to track the
alternate path the PID takes (see the following section for a
discussion). Drag the Path Locater icon (from the Main eVSM
Stencil) onto the Decision shape and connect it. The red
square appears briefly to indicate a glue connection. Double
click and select a path number for this alternate path.
2
1

Admit ?
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A060

1

Discharge

Cycle Time

5

Min

Group Size

1

PID

Cycle Time Per PID

Auto
Auto
Auto

Min
Min
Min

75

%

Activity Takt Time
Activity VA Per PID

Demand
Percent

Auto

Activity Demand
%

A080

Min

2

No

Admit

Yes
A030
2 1

Cycle Time

30

Min

Group Size

1

PID

Cycle Time Per PID

Auto
Auto
Auto

Min
Min
Min

25

%

Activity Takt Time
Activity VA Per PID

Admit ?

Demand
Percent

YES

25

%

NO

75

%

Auto

Min

The example above shows the 2 possible paths a patient can
take after the decision. Path 1 leads to discharge and Path 2
to admission. You will need to drag the optional ‘Activity
Demand %’ shape and glue it to the Activity Center shapes to
indicate the percent of demand flowing through each path.
Z110

Time Summary
Total Time

Auto

Hr

Auto

Min

1

Auto

%

Takt Time

Auto

Min

Total Value
Added
Value Added
Percent

Z115

1

Path 1 Summary
Path 2 Summary

2

Time Summary
Total Time

Auto

Hr

Auto

Min

1

Auto

%

Takt Time

Auto

Min

Total Value
Added
Value Added
Percent

You can then place two Time Summary (see Time Summary
section) shapes to summarize the alternate paths.
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Path Locater shapes
Every macro shape also has a ‘Path Locater’ shape that that
defaults to Path 1.
Path Locater
This variable can used to decide (for
example) if the VA or NVA time
component contributes to the ‘Lead
Time’ and if the VA component
contributes to the ‘Total Value
Added’ in the ‘Time Summary’. If a
component is not intended to
contribute to the totals its path
locater shape should be deleted or
changed to a different path number.

A010

1

Type
Queue
Queue Loss

xx PID
Auto

Min

Auto Day

Z010

1

Time Summary
Lead Time
Time Summary

Total Value
Added
Value Added
Percent
Takt Time

Auto

Day

Auto

Min

Auto

%

Auto

Min

Note the “”Path Locater” shapes glued onto the Time
Summary. This limits the summation calculation to the path
number (1 in this case)
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Rolling Time Calculation
Rolling Time

Rolling Time

Auto

Min

Optional Rolling Time shapes are available for all Shape
Centers. They are recognizable by a curved green arrow over
a clock in the icon.
Rolling Time is be used to show how long the PID has been
on the VSM up to that point.
Rolling Time is automatically calculated, but requires that
Shape Tags be connected by sequence arrows (see Tag
Sequence Arrow Section in “Analyzing with eVSM” Chapter)
and EVERY green shape upstream MUST also have ‘Rolling
Time’ attached.
A060
A010

1

Registration

Waiting Room
Wait

Tag Seq Arrow
30 Min

Activity Rolling
Time
89

Cycle Time

12

Min

Group Size

1

PID

Cycle Time Per PID
Activity Takt Time

Auto
Auto

Min
Min

Activity VA Per PID

Auto

Min

Rolling Time

Auto

Min
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Indicating Transportation or Transmit Method

Transport Center

Transmit Center

A010 1

Time
Between

A020 1

xx Day

Auto Day

Time
Between

xx Day

Auto Day

Delete the ‘Path Locater’ and the NVA data blocks if the NVA
time does not participate in the lead time calculation.
Right-click on the transport or transmit icons to select another
type from the family.
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Time Summary

Z010

1

Time Summary
Total Time
Time Summary

Total Value
Added
Value Added
Percent
Takt Time

Auto

Hr

Auto

Min

Auto

%

Auto

Min

Drag & drop to the bottom right of the page and just to the
right of the VA/NVA timeline.
Note that the “Path 1” filter shapes applied to the summation
calculations for ‘Total Time’ and ‘Total Value Added’ time.

Calculating the “Auto” Variables
Once you have entered data in all the input fields, make sure
that all the light green shapes are tagged (See the ‘Tagging
Shapes’ section earlier in this chapter).
Click the “Q” button in the toolbar to execute the built-in
equations. This will create values in all the “Auto” fields.
Quick eVSM
Whenever data is changed on the map, this button should be
clicked to update the map.
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Cycle Time / Takt Time Chart
Edit Chart DataPlot ChartCreate
Spreadsheet

CT / TT Chart

Drag & Drop the chart on the page and then Right-Click for
the ‘Plot Chart’ option. It can be filtered by path number by
gluing on a ‘Path Filter’ shape to the bottom right of the chart
shape.
Cycle Time / Takt Time Chart

25
20

Min

15
10
5

Activity Takt Time
Cycle Time Per
PID

0
A120

A130

D

X/
R
D XI
is n
ch f o
ar &
ge

ed
ur
e

Pr
ep

A100

Pr
oc

Ad

m
is
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A080
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Lead Time Chart
Edit Ladder Chart DataPlot Ladder
ChartCreate Spreadsheet

Lead Time Chart

Drag & Drop the chart on the page and then Right-Click for
the ‘Plot Chart’ option. It can be filtered by path number by
gluing on a ‘Path Filter’ shape to the bottom right of the chart
shape.
Lead Time Components
Hr
0

0.2

0.4

0.6

0.8

1

1.2

1.4

Activity
VA Per
PID
Wait

A080Admissi
A090Wa A100Pr
on
it Rm1
ep
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A110Wait
Rm 2

A120Proc A130DX/RX
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Info &
Discharge
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A150Wait
Rm 3
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Quick Healthcare VSM Example

Scheduler

Appt
Info.

Clinic
Info.

A080

A180

Admission

1

Wait
Wait

A090

1

1

Prep

Wait Rm1

64 Min

Min Wait
8 Min
Time
Max Wait
81 Min
Time

Cycle Time

11

Min

Group Size

1

PID

Cycle Time Per PID

11.00

Min

Activity Takt Time

15.00
11.00

Min
Min

5

Min

14

Min

Activity VA Per PID

Min Cycle
Time
Max Cycle
Time

64.00

A100

1

Min

Wait

Min

Min Wait
1 Min
Time
Max Wait
15 Min
Time

Cycle Time

21

Min

Group Size

1

PID

Cycle Time Per PID

21.00

Min

Activity Takt Time

15.00
21.00

Min
Min

16

Min

27

Min

Activity VA Per PID

Min Cycle
Time
Max Cycle
Time

3.00
11.00

3

Min

Min

21.00

Min

HC
DATA

Use the Value Stream Map (from Review by Cindy
Jimmerson) above as an exercise to create your own first
VSM using Quick Healthcare.
If you have any questions or problems contact us at
support@evsm.com.
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Z020

Cardio

Cardiology
Office

Daily Patients

A120

A110

1

Procedure

Wait

16 Min

19

Min

Group Size

1

PID

Cycle Time Per PID
Activity Takt Time

19.00
15.00

Min
Min

Activity VA Per PID

19.00

Min

18

Min

22

Min

Min Cycle
Time
Max Cycle
Time

16.00

A150

1

Wait Rm 3
Cycle Time

Min

Wait

2

Min

Min Wait
0 Min
Time
Max Wait
14 Min
Time

Rev 4, July 23rd

95

Hr

Min

10

60

60

Hr

Min

Sec

1

DX/RX Info
& Discharge
Cycle Time

10

Min

Group Size

1

PID

Cycle Time Per PID
Activity Takt Time

10.00
15.00

Min
Min

Activity VA Per PID

10.00

Min

7

Min

12

Min

Min

Min

10.00

Min

Z200

Patient Flow For Treadmills
John Abrahams

PID

Day

Min Cycle
Time
Max Cycle
Time

2.00
19.00

40

A130

1

Wait Rm 2
Min Wait
1 Min
Time
Max Wait
80 Min
Time

1

1

Time Summary
2.43
Total Time

Hr

Total Value Added
Value Added
Percent

61.00

Min

41.78

%

Takt Time

15.00

Min
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Key Creator

Key Creator

Adding this Shape to a map will give
you a summary of all the icons used on
the map.

Var Key Creator

Var Key Creator

Adding this Shape to a map will give
you a summary of all the variables
used on the map.

Quick Healthcare Info

Quick HC Info

This shape contains an image that lays out the content of the
Quick HC stencil on a single page and provides annotation on
the equations that are involved in calculating all the “Auto”
fields.
Drag out the shape for Preview or Printing.
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Quick HC Summary
Quick HC stencils provide a standard, easy, and rapid means
of creating, analyzing, and visualizing the map.
The Quick Healthcare stencil in eVSM V5 provides a highly
productive way of working with value stream maps. The
eVSM group plans to create further “Quick” stencils in
response to customer demand. If you have such a request
please email us at support@evsm.com.
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5. Quick MCTLite
What is Quick MCTLite ?
Manufacturing Critical-path Time (MCT) is Quick Response
Manufacturing’s (QRM) metric for Lead Time. The Quick
MCTLite allows for quick drawing of maps with Flow Times
and the MCT chart.

Opening the Quick MCTLite Stencil.
From the eVSM Toolbar, click on the Quick MCT button to
open up the MCT stencils.
Quick MCT Button

Quick MCT Stencil

Icon

Macro Shape
A040

Mfg Wait
Wait
Mfg NVA
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xx

Day

Auto Day
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Can Quick eVSM stencils be used on existing maps ?
You can only use the Quick eVSM stencils for completely
NEW maps. The stencils relies on a standard set of names,
units and eqn’s that old maps will not be compliant to.

Quick eVSM Stencils : Icon Conventions
The icons in the Quick eVSM stencils (such as the Quick
MCTLite stencil) have the following conventions:
The 3 RED Quick MCT Icons need to
be placed on EVERY map and should
be the first items placed on the map.
Process Groups (Planning, Supplier
Management (SM), Manufacturing)
each have their own color Main icons.

These icons represent Charting and
Summaries.
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Recommended Layout for Quick eVSM

Note that the main eVSM stencil (typically named eVSM
vX.XX) is on the left of the screen. We will refer to this as the
“Main Stencil”. Its important that this stencil is never closed
because closing it disables eVSM toolbar functions.
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Any Quick eVSM stencils (such as Quick MCTLite) are
docked on the right of the screen. We will refer to such
stencils as the “Quick Stencil”. Click and drag the Quick
Stencil header bar to move it to this docked position.
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Icon Help
Quick eVSM Icons all have associated help which is accessed
by selecting the icon in the stencil than clicking ‘iQ’ in the
toolbar.

Drag and Drop Behavior
When you drag and drop an icon on the page it creates either
a single shape or a macro shape (a set of connected
Shapes).

Moving Shapes On The Map
When the macro shapes
corresponding to the Main icons
are dragged onto the page, they
include an ‘Anchor Shape’ that is
colored. To move the macro shape
as a whole, this anchor shape
should be moved. In the diagram,
the truck is the anchor shape.
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A030

Mfg WIP
Inventory

xx

Item

Mfg NVA

Auto

Day
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Zooming In and Out
CTRL-SHIFT-Drag Select region (Zoom into the selected
region)

Page Resizing
When you run out of space on the drawing page, DO NOT
resize eVSM shapes. Instead just make the drawing page
bigger. An easy way to do this in Visio is to hold down the
CTRL key and move the cursor to any edge of the page. The
cursor will turn into a double-headed arrow. Just grab the
edge and pull to required size. Avoid the page corners when
re-sizing the page.

Snap To Grid
Shapes are designed to be grid-sized. Snap shapes to grid
locations for easy alignment.

Resizing Shapes
Avoid resizing shapes whenever possible. Shapes are
designed to fit together and resizing a shape will make “fit”
difficult and create extra work.

Text Editing
Double-click a shape to edit its text.
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Tagged and Path Located Shapes
Some icons in the stencil have shapes that are pre-tagged via
an “Operation Tag”.

Operation Tag

A020

Mfg WIP
Inventory

xx

Item

Mfg NVA

Auto

Day

Mfg WIP

When the shape is dragged onto the map its operation tag will
“auto-number” to create a unique tag ID. You can double-click
and change the ID but it MUST be unique on the map and it
MUST be an alphabetic character followed by 3 numerals.
The charts in Quick MCT are plotted in tag alphabetic
sequence order.
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Data Shapes
Quick eVSM data shapes have 3 types of entries:
Shapes with xx in the center
field indicate values that
MUST be entered.

Cycle Time

x.xx

Min

Some shapes have default values
already entered. Override these
when necessary.

Flow Time

0

OHr

Mfg VA

Auto

Min

Mfg NVA

Auto

Day

Any shapes with ‘Auto’ fields
should be left alone. They will be
automatically calculated.
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Path Locater shapes
Every macro shape that has a Value Added (VA) or Non
Value Added (NVA) data shape contribute to MCT Total and
Response.
A130

Mfg WIP
Mfg WIP

Inventory

xx

Item

Mfg NVA

Auto

Day

Path Filter
MCT Summary
2
Note the “”Path Filter”
Z010
1
shapes glued onto the top
MCT Summary
of the ‘MCT Summary’
shape. These filters limit
MCT Total
Auto
CDay
the summation
calculation to the path
MCT Response
Auto
CDay
numbers ( 1 and 2 in this
case). They are also used
to map separate paths in
the MCT Chart.
106
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Drawing Your First Map With Quick MCT Stencil

Place the ‘MCT Data’ on the
bottom left of the page.
MCT Data

Fill out all the “XX” values in the units
converters. In these converters time units
prefixed with an “O” refer to office times,
those with a “C” refer to calendar times and
those without a prefix relate to production
times

Time Center

Wk Day

Wk ODay

xx

xx

xx

Day

Hr

107

xx

ODay OHr

Wk CDay CHr CMin OHr OMin Hr
7

24

60

60

60

60

60

Min
60

CDay CHr CMin CSec OMin OSec Min Sec
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MCT FG
Z260

MCT FG
Customer

Start drawing the map by dragging out
the MCT FG shape and placing it to the
right of the page. Leave the “Auto”
fields alone. These will be calculated
later using the built-in MCT Equations.
Fill in any “XX” values.

Customer
Daily Demand

xx

Item

A270

FG LOG
Flow

xx

Day

FG LOG NVA

Auto

CDay

A280

FG Inv
FG
Inventory

xx

Ite
m

FG Inventory NVA

Auto

CDay

Planning Centers
Drag out the wait and activity shapes for Planning and fill in
any values. . The “Activity Wait Time” field refers to the NVA
time within an activity.

108

5. Quick MCTLite

108

Planning Cont’d

A210

Planning Activity
Plan Activity
Cycle Time

xx

OMin

Flow Time

0

OHr

Pln VA

Auto

CMin

Pln NVA

Auto

CHr

Flow Time is the total time taken by an item entering this
process to exiting it (including any non-processing
(NVA) time). Cycle Time is the actual hands on time.

A010
Planning Queue
Wait

xx

OHr

Pln NVA

Auto

CHr

Plan Wait

‘Wait’ time captures waste due to queues.
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SM (Supplier Management) Centers
Drag out as many ‘ MCT Supply ‘ shapes as there are
significant raw materials that you want to model on the map.
Position each set vertically under the prior one as you drag it
out and on the left of the drawing. You can easily make the
page bigger if needed (See the eVSM Environment Chapter in
the on-line user manual)

MCT Supply

A240
A250
A260

Material

Supplier

A210

Lead Time

xx

Day

Raw LT NVA

Auto

CDay

Raw LOG
xx
Flow
Raw LOG NVA

Auto

Raw
Inventory

xx

Item

Raw Inv NVA

Auto

CDay

Day
CDay

Drag out the wait and activity shapes for SM and fill in any
values.

SM Wait

110

SM Activity
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Mfg (Manufacturing) Centers
Drag out manufacturing WIP, Wait and Activity shapes to
complete the VSM

Mfg WIP

111

Mfg Activity
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Mfg Wait
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Putting path numbers on shapes
Use the red “eVSM Tag Path Locater Defaults” toolbar button
to set up path number defaults and then use the red “eVSM
AutoPath” toolbar button to pick each set of activity shapes in
sequence and apply path numbers to them and staring at the
customer shape. The MCT chart will have one bar for each
path number
eVSM AutoPath
eVSM Tag Path Locater Defaults

Calculating the “Auto” Fields
Click the “Quick eVSM” button in the eVSM toolbar. Give it
time to calculate all the fields (can take a few minutes). You
must click this button to rerun calculations when you change
map data.
Drawing the MCT Chart

Quick eVSM

Drag out the ‘White/Gray Map’ shape and attach “Path Filter”
shapes to it from the stencil on the left of the page. These are
glued to the bottom right corner. One path filter shape for
each path number. Now right-click the chart shape and select
the “plot” option
MCT Summary

White/Gray Map

Drag out the ‘MCT summary’ shape and attach a “path
locater” shape to the top right of the activity. Double click the
path locater shape to select the path you want a summary for.
Only ONE path locater should be attached to the summary.
Once this is done click the “eVSM Calculator” button in the
toolbar to calculate the summary values
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Connecting Activities With Arrows
ExpeditedInformationKa
nbanMaterialPushServic
e

Stepped Arrows

FIFO Arrow

A060

A060

Mfg Activity

Cycle Time

Finished Goods

Mfg Activity

xx

Sec

Cycle Time

Flow Time

0

Hr

Mfg VA

Auto

Min

Mfg NVA

Auto

Day

xx

Sec

Flow Time

0

Hr

Mfg VA

Auto

Min

Mfg NVA

Auto

Day

Curvable
Arrows

One of the arrows above should be used to connect activities
together to show the sequence. A Right-Click provides
additional formats to show the type of flow (PUSH in the
above example).

Electronic Info
Flow

113

The red jagged arrow is used
to represent electronic
information flow (for example,
an email of a forecast from a
customer).
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6. Quick MCT
What is Quick MCT ?
Manufacturing Critical-path Time (MCT) is Quick Response
Manufacturing’s (QRM) metric for Lead Time. The Quick MCT
is the more advanced template that features detailed
variables for full VSM and MCT calculations

Opening the Quick MCT Stencil.
From the eVSM Toolbar, click on the Quick MCT button to
open up the MCT stencils.
Quick MCT Button

Quick MCT Stencil

Icon

Macro Shape
A040

Mfg Wait
Wait
Mfg NVA
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xx

Day

Auto Day
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Can Quick eVSM stencils be used on existing maps ?
You can only use the Quick eVSM stencils for completely
NEW maps. The stencils relies on a standard set of names,
units and eqn’s that old maps will not be compliant to.

Quick eVSM Stencils : Icon Conventions
The icons in the Quick eVSM stencils (such as the Quick MCT
stencil) have the following conventions:
The 3 RED Quick MCT Icons need to
be placed on EVERY map and should
be the first items placed on the map.
Process Groups (Planning, Supplier
Management (SM), Manufacturing)
each have their own color Main icons.

Yellow Quick eVSM Icons represent
optional add-ons to the main macro
shapes. These icons are named to
correspond to the Main icons to which
they can be added.
These icons represent Charting and
Summaries.
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Recommended Layout for Quick eVSM

Note that the main eVSM stencil (typically named eVSM
vX.XX) is on the left of the screen. We will refer to this as the
“Main Stencil”. Its important that this stencil is never closed
because closing it disables eVSM toolbar functions.
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Any Quick eVSM stencils (such as Quick MCT) are docked on
the right of the screen. We will refer to such stencils as the
“Quick Stencil”. Click and drag the Quick Stencil header bar to
move it to this docked position.
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Icon Help
Quick eVSM Icons all have associated help which is accessed
by selecting the icon in the stencil than clicking ‘iQ’ in the
toolbar.

Drag and Drop Behavior
When you drag and drop an icon on the page it creates either
a single shape or a macro shape (a set of connected
Shapes).
Except yellow icons all the others are independent and do not
need to be attached to other items when they are being
dropped on the page.
Yellow icons represent add-on shapes. They need to be
positioned and attached to their parent shape as part of the
drag & drop process.

Moving Shapes On The Map
When the macro shapes
corresponding to the Main icons
are dragged onto the page, they
include an ‘Anchor Shape’ that is
colored. To move the macro shape
as a whole, this anchor shape
should be moved. In the diagram,
the ‘Mfg WIP’ is the anchor shape.
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A030

Mfg WIP
Inventory

xx

Item

Mfg NVA

Auto

Day
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Zooming In and Out
CTRL-SHIFT-Drag Select region (Zoom into the selected
region)

Page Resizing
When you run out of space on the drawing page, DO NOT
resize eVSM shapes. Instead just make the drawing page
bigger. An easy way to do this in Visio is to hold down the
CTRL key and move the cursor to any edge of the page. The
cursor will turn into a double-headed arrow. Just grab the
edge and pull to required size. Avoid the page corners when
re-sizing the page.

Snap To Grid
Shapes are designed to be grid-sized. Snap shapes to grid
locations for easy alignment.

Resizing Shapes
Avoid resizing shapes whenever possible. Shapes are
designed to fit together and resizing a shape will make “fit”
difficult and create extra work.

Text Editing
Double-click a shape to edit its text.
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Tagged and Path Located Shapes
Some icons in the stencil have shapes that are pre-tagged via
an “Operation Tag”.

Operation Tag

A020

Mfg WIP
Inventory

xx

Item

Mfg NVA

Auto

Day

Mfg WIP

When the shape is dragged onto the map its operation tag will
“auto-number” to create a unique tag ID. You can double-click
and change the ID but it MUST be unique on the map and it
MUST be an alphabetic character followed by 3 numerals.
The charts in Quick MCT are plotted in tag alphabetic
sequence order.
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Data Shapes
Quick eVSM data shapes have 3 types of entries:
Shapes with xx in the center
field indicate values that
MUST be entered.
Some shapes have default values
already entered. Override these
when necessary.
Any shapes with ‘Auto’ fields
should be left alone. They will be
automatically calculated.

Cycle Time

x.xx

Min

Qty Per Cycle

1

Ord

Cycle Time Per Item

Auto
Auto

Min
Min

Activity Takt Time

Most data shapes have a Name, Value, Unit composition. The
exception are the ‘Value Added’ and ‘Non Value Added’
shapes where the name is implied.

Auto Day
Auto Min
Non Value Added
Value Added
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Path Locater shapes
Every macro shape that has a Value Added (VA) or Non
Value Added (NVA) data shape contribute to MCT Total and
Response.
A130

Mfg WIP
Mfg WIP

Inventory

xx

Item

Mfg NVA

Auto

Day

Mfg WIP NVA

Auto

CDay

Auto Day
2
1

Z050
MCT Summary

MCT Summary

Note the “”Path Filter”
MCT Total
shapes glued onto the top
MCT Response
of the ‘MCT Summary’
shape. These filters limit
CMP VA
the summation
CMP VA to MCT
calculation to the path
Total Percent
numbers ( 1 and 2 in this
Takt Time
case). They are also used
to map separate paths in
the MCT Chart.
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Auto

CDay

Auto

CDay

Auto

Day

Auto

%

Auto

Min
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Drawing Your First Map With Quick MCT Stencil

Place the ‘MCT Data’ on the
bottom left of the page.
MCT Data

Fill out all the “XX” values in the units
converters. In these converters time units
prefixed with an “O” refer to office times,
those with a “C” refer to calendar times and
those without a prefix relate to production
times

Time Center

Wk Day

Wk ODay

xx

xx

xx

Day

Hr

123

xx

ODay OHr

Wk CDay CHr CMin OHr OMin Hr
7

24

60

60

60

60

60

Min
60

CDay CHr CMin CSec OMin OSec Min Sec
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MCT FG
Z140

MCT FG

Start drawing the map by dragging out
the MCT FG shape and placing it to the
right of the page. Leave the “Auto”
fields alone. These will be calculated
later using the built-in MCT Equations.
Fill in any “XX” values. On the
customer shape the “Required Order
Support Qnty” is used to determine
whether Supplier Lead Time is included
in the MCT Response. FG Prep in the
Transport Block refers to any time the
Finished Goods spend in warehouse
and/or packing activity.

Customer
Customer Daily
Demand
Required Order
Support Qnty

xx
xx

Item
Item

A150

Time
Between
Transport
Time
FG Prep

xx
xx
xx

Hr

FG LOG NVA

Auto

CDay

Day
Day

A160

FG Inv
Inventory

xx

FG Inventory

Auto
Auto

FG Inventory NVA

Auto

Item
Item
CDay

CDay

Planning Centers
Drag out the wait and activity shapes for Planning and fill in
any values. . The “Activity Wait Time” field refers to the NVA
time within an activity.
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Planning Cont’d
A210

Planning Activity

Cycle Time

xx

OHr

Activity Wait
Time

0

ODay

Pln VA

Auto

CMin

Pln NVA

Auto

CHr

Plan Activity

‘Activity Wait Time’ is any time within a process that
an item is not being worked on (NVA time). ‘Cycle
Time’ is the actual hands on time.

A290
Planning Queue
Plan Wait
Wait

xx

OHr

Pln NVA

Auto

CHr

‘Wait’ time captures waste due to queues.
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SM (Supplier Management) Centers
Drag out the wait and activity shapes for SM and fill in any
values. . The “Activity Wait Time” field refers to the NVA time
within an activity.

Drag out as many ‘ MCT Supply ‘ shapes as there are
significant raw materials that you want to model on the map.
Position each set vertically under the prior one as you drag it
out and on the left of the drawing. You can easily make the
page bigger if needed (See the eVSM Environment Chapter in
the on-line user manual)

MCT Supply

A110

A130

Material

A120

Inventory

Supplier

Raw Inv
Raw Inv NVA

Activity Lead
Time

xx

Day

Applied Lead Time

Auto

CDay

Item

Auto Item
Auto

CDay

Time
xx Day
Between
Transport
xx Hr
Time
Raw LOG NVA
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xx

Auto

CDay
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Mfg (Manufacturing) Centers
Drag out manufacturing WIP, Wait and Activity shapes to
complete the VSM

Mfg WIP

Mfg Activity

Mfg Wait

Tagging the shapes in Sequence Order
Use the red “eVSM Tag Path Locater” toolbar button to
set up tag defaults and then use the red “eVSM
AutoTag” toolbar button to pick each set of activity
shapes in sequence and apply tags to them. The MCT
chart will be plotted in tag sequence. For help on either
of these button search the online user manual.
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Putting path numbers on shapes
Use the red “eVSM Tag Path Locater Defaults” toolbar button
to set up path number defaults and then use the red “eVSM
AutoPath” toolbar button to pick each set of activity shapes in
sequence and apply path numbers to them and staring at the
customer shape. The MCT chart will have one bar for each
path number
eVSM Tag Path
eVSM AutoPath
Locater Defaults

Calculating the “Auto” Fields
Click the “Quick eVSM” button in the eVSM toolbar. Give it
time to calculate all the fields (can take a few minutes). You
must click this button to rerun calculations when you change
map data.
Quick eVSM

Drawing the MCT Chart
Drag out the ‘MCT Chart’ shape and attach “Path Filter”
shapes to it from the stencil on the left of the page. These are
glued to the bottom right corner. One path filter shape for
each path number. Now right-click the chart shape and select
the “plot” option
MCT Summary

MCT Map

Drag out the ‘MCT summary’ shape and attach a “path
locater” shape to the top right of the activity. Double click the
path locater shape to select the path you want a summary for.
Only ONE path locater should be attached to the summary.
Once this is done click the “eVSM Calculator” button in the
toolbar to calculate the summary values
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Connecting Activities With Arrows
ExpeditedInformationKa
nbanMaterialPushServic
e

Stepped Arrows

1

1

FIFO Arrow
Activity

Finished Goods

Cycle Time x.xx
Activity
1
Time Per
Cycle Day
Time Per Item
Auto
Activity Takt Time
Activity VA Per Item

Curvable
Arrows

Auto

Auto
Auto

Activity
Min

Cycle Time x.xx
Activity
1
Time Per
Cycle Day
Time Per Item
Auto

Hr
Min
Min
Min

Activity Takt Time
Activity VA Per Item

Min

Auto

Auto
Auto

Min
Hr
Min
Min
Min

Min

One of the arrows above should be used to connect activities
together to show the sequence. A Right-Click provides
additional formats to show the type of flow (PUSH in the
above example).

Electronic Info
Flow
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The red jagged arrow is used
to represent electronic
information flow (for example,
an email of a forecast from a
customer).
6. Quick MCT
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7. Drawing Value Stream Maps
Help Movies
These and other short movies about using eVSM are
available at www.evsm.com/help
Draw the Flow

Work with Variables

Add Map Data

Hyperlink Maps

Fix common mapping problems

Insert Activities

Working with Variables

Create Map Key

Identifying Customers
Customer

Start the map at the
customer end.

Outside
Source

130
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Identifying Operational Steps
Identify operations in the value
stream and start at the customer
end.

Process

Use the Right Mouse button if you
need to swap to another process
shape.

Operation
Shapes

Connecting Operational Steps with Arrows

Drag and drop, then glue arrows to
the operations or their data shapes
for easy future modification of the
map.

Process

Process

Stepped
Arrows

131

Use the Right Mouse button to
swap to another arrow type (like
this Push arrow)

7. Drawing Value Stream Maps
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Adding Operational Data
Value stream data which you may later want to use in
calculations must be represented in eVSM data shapes.
eVSM has the following data shapes:

Long NVU

Name

Short NVU

Value Unit

Name

Value
Added

Value

Unit

Non Value
Added

Value

Unit

Value Unit

Data shapes consist of two or three fields. To move or delete
a data shape, you MUST click on the Value field. To edit any
of the fields, simply double-click on it and let the program
guide you through how you can change it.

Process
Name
Value Unit
Value

Name
Name

Unit
Value

132

Value Unit
Value Unit

Data shapes must be glued
directly, or via other shapes,
to the activity they represent.

Unit

7. Drawing Value Stream Maps
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Variable Names and Units
To add variable names/units to the right mouse button (RMB)
menu, follow these steps:
1. Click the following button in the eVSM Toolbar to open the
Name & Unit Manager (NUM) dialog.
eVSM Name and Unit Manager

3. To add a new unit, click the “New Unit…” button.
4. All variable names must have a default unit. When adding
new variable names, first make sure that the unit you wish
to make the default for the new variable exists in the units
list. Then, click the “New Name…” button and follow the
prompts.
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Adding Additional Data Shapes
Process

Long
NVU

CT
CO

20
3

sec
min

Process
CT

20

sec

CO

3

min

x.xx

Unit

Additional data can be added to a
process. Drag & glue new NVU to
the bottom of existing NVU.
Data shapes that do not touch the
operation or its data shapes
directly should be associated with
the operation by dragging the
flying yellow connector and gluing
it to the operation.
Note: Flying connectors should
NOT be used where shapes are
touching.

Representing VA & NVA data

Process

Process

xx
xx

Value
Added
134

Unit

Day
s

Non Value
Added

VA and NVA shapes
are available to
construct a timeline
on the map.
Glue these shapes to
operational shapes
with a flying
connector.

When there are several VA/NVA
metrics to be tracked, the Long NVU
shape should be used instead of the
specific VA, NVA shapes.
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Representing Inventory & Queues
Process

Process

Inventory
Shapes

Inventory shapes can be placed on the
drawing, using the flying yellow
connectors to glue them to operations.
Use the Right Mouse button to swap to
another inventory shape (Queue, In-tray
etc..).

Representing Inventory Data

Short
NVU
LH
20 plts

Drag out the NVU shape and glue it to the
bottom of the inventory rectangle to
document inventory type and quantity. Use
additional triangles and NVU blocks for
each inventory type.
Each inventory item associated with any
one operation MUST have a different name.

Representing Supermarkets and Buffers

Supermarket

LH
20 plts

Supermarket and Buffer shapes
work in a similar way to the
Inventory Shape. Any data must
be glued to the base of the shape

Short NVU
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Representing Transport Method and Data
Process

Transport
Shapes

Finished
Goods

Drag out Transport Shapes
and place them on the map or
glue them to arrows. NVU
shapes holding related
variables can be attached to
the base of the icons.
Use the Right Mouse button to
swap to another transport type
(Train, Helicopter etc..).

Representing Transmit Method and Data

Transmit
Shapes

136

Transmit Shapes work
in a similar way to
Transport Shapes and
are generally applied
to information flow.
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Frameless Transport & Transmit shapes
Right-click on a transmit or
transport shape on the map to
show alternate methods.

Transmit
Shapes

By Foot
Computer
Fax
Pager / Radio
Phone
Post
Print
Web Form
_______________
Framing

At the bottom of the list is a
“Framing” option that allows
the outer box around the
shape to be turned on or off.
When turned off the shape
looks as below:

Using Unit Converters

Units
Converter
Days

Hrs

Mins

15
Hrs

60
Mins

60
Secs

137

The Units Shape in the stencil is used to
define conversion factors between units in
each family. If a single variable on the map
(like Cycle Time) has data values in different
units (like Hrs and Mins) then conversion
factors must exist linking these units.
This is an example of a “time” unit family. In
eVSM the first letter of a unit name is
sometime used as its abbreviation so its
important that no two members of the unit
family have the same first character. Note the
use of “PSfts” instead of “Shfts” to avoid first
letter conflict with the “Secs” unit.
7. Drawing Value Stream Maps
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Multi-Unit Edit
This function allows you to enter and edit data values in a
combination of related units. Available in Long and Short
NVU’s shapes only. Steps:
1. Setup Units Convertors for the related units.
Days

Hrs

Mins

16

60

60

Hrs

Mins

Secs

2. Right-mouse click on the Value field of the NVU and
select the “Multi-Unit Edit” command.
Cycle Time

x.xx

Hrs

Enable Flying ConnectorMulti Unit
Edit

3. Enter values in the Data Entry form.

4. See the result in the NVU.
138

Cycle Time

7. Drawing Value Stream Maps

2.753

Hrs
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Automove
Automove makes it easier to insert/remove activities from
large map. This function consists of two buttons:
eVSM Link Activities
eVSM Unlink Activities
When the Link Activities button is clicked, all activity shapes in
each flow line are linked (rigidly locked) to each other. In this
mode, if any activity block is selected and moved, it gets
unlinked from the upstream activity. All the downstream
activities stay linked and move with it.
The Unlink Activities button is used to exit this mode. It is
active when the shapes are in the linked mode.
Steps:
1. Click the eVSM Link Activities button.
2. Select and move activity downstream of where space
needs to be created or removed.
Move

3. Click the eVSM Unlink Activities button to exit Automove
mode.
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Autofix
Autofix corrects some common problems on maps. To run,
click this toolbar button:
eVSM Autofix
Problems fixed by the Autofix function include:
1. Removes hidden data shapes: sometimes when using
copy/paste, multiple copies are created and duplicates are
hidden under visible data shapes. Finding and removing
these can be tedious, Autofix automatically deletes such
duplicates.
2. Automatically glues data shapes and arrows based on
proximity.
Before

After

3. Works around the Visio glue limitation of 10+ shapes.
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Manipulating Text on Connectors
Text can be added to any connector by double-clicking and
typing.

Text on
Connector

The Visio Text Block Tool can be used to move the text
position along the arrow. Note: The Text Box Tool is part of
Visio, not eVSM tools, and can be found in the Visio menu.
Text Block Tool

Text on
Connector

Text on
Connector

Caution: Be sure to de-select the Text Block Tool when
finished.
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Creating Drill-Down Maps
eVSM Drill Down
The eVSM Drill Down button in the toolbar can be used to
create a sub-page corresponding to an Operation Shape on
the map. Pick the Operation Shape and then click the Drill
Down button. A hyperlink is automatically created from the
Operational Shape to the sub-page

Migrate Maps to eVSM v5
The following button in the toolbar will migrate eVSM v2, v3,
and v4 maps to eVSM v5 format.
eVSM v5 Migration
Once a map is migrated to v5, it cannot be opened in older
releases of eVSM.
If you need to open an eVSM v5 file in, say v3 (or any earlier
version of eVSM) for viewing/printing purposes only, here is a
workaround.
1. Start eVSM and switch VB Macros Off. Click “Tools >
Options > Security”.
2. Switch “Off” this
checkbox.
3. Exit Visio and open the eVSM v5 file.
Note: Remember to reverse Step 2 above when you wish to
use eVSM v5 again.
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Drawing a Key of Icons
The eVSM Key Creator generates a key of the icons used on
the current drawing.
Key Creator

Drag out the Key Creator icon and drop it in the space on your
map where you want to display the key.
Note: This automatic function is restricted to eVSM shapes on
the current drawing page. Some eVSM shapes, eg. data
shapes such as long and short NVU’s are intentionally
omitted.
The Key display uses the eVSM Table shape. This allows you
to delete/add columns (see how in the “Working with Tables”
chapter) and also change the annotation of the key.

Cross
Dock

143

Finished
Goods

Inventory

Outside
Source

Process

Summary

Truck
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Units
Warehouse
Converter
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8. eVSM Data Link
The eVSM Data Link function allows importing of data from
external sources (such as databases) into eVSM data shapes.

Excel

SharePoint

Access

SQL
Server

OLEDB

ODBC

A020

Drill

Cycle Time

12.00 Sec

Batch Size

3.00

Unit

Cycle Time
per Unit

Auto

Sec

Note: This function is only available with Visio 2007
Professional edition.
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Steps to Link Data
1. Here is the data in Access:

This column contains the
Operation Tag numbers which
will match with the VSM

We wish to import the
Cycle Time and Batch
Size from the database

2. Here is the map:
A020

A020

Stamp

A020

Drill

Assemble

Cycle Time

x.xx

Sec

Cycle Time

x.xx

Sec

Cycle Time

x.xx

Sec

Batch Size

x.xx

Unit

Batch Size

x.xx

Unit

Batch Size

x.xx

Unit

Cycle Time
per Unit

Auto

Sec

Cycle Time
per Unit

Auto

Sec

Cycle Time
per Unit

Auto

Sec
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Steps to Link Data (Cont’d)
3. In the Visio menus, click “Data > Link Data to Shapes…”

Select the
Access file

Follow the
instructions

Here is the
data in Visio
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Steps to Link Data (Cont’d)
4. Click “Data > Automatically Link…”, follow the wizard,
and link the “tag” data column to the shape text for all
shapes on page. The wizard allows you to filter out any
unwanted columns and rows. This action will add shape
data to the Operation Tags on the map.
Here is an example:

5. Click the Data Link button in the eVSM Toolbar
eVSM Data Link
A020

Here is the data in
eVSM data shapes

A020

Stamp

A020

Drill

Assemble

Cycle Time

30.00 Sec

Cycle Time

12.00 Sec

Cycle Time

6.00

Sec

Batch Size

10.00 Unit

Batch Size

3.00

Unit

Batch Size

1.00

Unit

Cycle Time
per Unit

Auto

Cycle Time
per Unit

Auto

Sec

Cycle Time
per Unit

Auto

Sec
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9. Drawing Spaghetti Diagrams
Help Movies
Draw Spaghetti Diagrams

Spaghetti Diagrams highlight wasted journeys and effort by
visualizing motion between activity centers. The eVSM
Spaghetti Diagram function allows you to draw paths on a
floor plan (or any geographic map) and then export a Path
Report to Excel.
Floor Map

Spaghetti
Path

Spaghetti
Place

Spaghetti
Report in Excel

TO
ER Bay 9
X-ray waiting area
X-ray Room 1
ER Bay 9

148

COLOR

DESCRIPTION
Patient assisted in wheelchair
patient escorted to X-ray waiting area
Patient to X-ray
Patient returned to Bay 9

DATE
3/3/2007
3/3/2007
3/3/2007
3/3/2007

9. Drawing Spaghetti Diagrams

TIME
5:36pm
6:20pm
6:32pm
6:45pm

DISTANCE
102
58
27
62

148

Steps to Create a Spaghetti Diagram
1. Draw or import a floor map. Visio can import most bitmap
formats as well as AutoCAD drawings.
2. Click the Spaghetti Diagram button in the eVSM toolbar.
This will open the eVSM Diagrams stencil.
Spaghetti Diagram

14

3. Drag out a Spaghetti Scale shape from the eVSM
Diagrams, and stretch it out to exactly fit a known
dimension on the map. The known dimension could be a
map scale if available, or a floor dimension you have
measured. Enter the actual dimension value on the scale
shape.

Spaghetti
Scale

4. Define Activity Centers by dropping and naming a
Spaghetti Place icon onto the diagram for each place.

Spaghetti
Place
149
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Steps To Create A Spaghetti Diagram (cont'd.)
6. Use the Visio line drawing tools to map the paths. You
must ensure that each path starts and ends in a
Spaghetti Place icon. You can set color and line
thickness of the paths using standard Visio formatting.
In Visio 2003/2007, the line drawing tools are in the
Drawing Toolbar. This can be opened via the right-mouse
menus on the Visio Toolbars.
Any of the line tools
in the Drawing
toolbar can be used

In Visio 2010, the drawing tools are near the center of the
"Home" ribbon.

Line tools in
Visio 2010

150

9. Drawing Spaghetti Diagrams

150

7. Click the Spaghetti Diagram button again. eVSM will
create a spreadsheet report of the paths.
8. Additional attributes can be added to the path lines via
Visio Custom Properties. Select a path line, and click
“View>Custom Properties”.
Custom Prop...

FROM

Registration

TO

ER Bay 9

DISTANCE

102

SEQUENCE

1

DESCRIPTION

Patient assisted in wheelchair

DATE

3/3/2007

TIME

5:36pm

The next time the Spaghetti report is generated, the path
attributes will be transferred to the report.
Note that the Spaghetti Diagram button recreates the
Excel report. It DOES NOT update it.
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10. Drawing Communication Circles
Help Movies
Draw Communication Circles

Communication Circles allow you to visualize all the
transactions in a given pathway or process.
Example:
PHYSICIAN
ER UNIT
CLERK

PATIENT

CHARGE
NURSE

VOLUNTEER

NURSE
BILLING

ADMITTING

SOCIAL
SERVICES

Number Of Steps = 14
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Steps to Generate a New Communication Circles
1. Follow a pathway or process and record all transactions
in an Excel table in the following format. The first row in
the spreadsheet must contain the column headers as
shown. Save the Excel file anywhere on your machine.
FROM
Registration
Registration
Nurse
Nurse
Physician

TO
Patient
Nurse
Patient
Unit Clerk
Patient

2. In eVSM, click the Communication Circle button in the
eVSM toolbar. This will open the “eVSM Diagrams” stencil.

Communications Circle

3. Drag out a Communications Circle shape from the
“eVSM Diagrams” stencil. This will create a blank circle
on your drawing. Adjust the position and size of the
circle to your liking.
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Steps to Generate a Communication Circles (Cont'd)

4. Click the “Import Communications From Excel” command
in the right-mouse-button menu of the circle.
Import members from Excel
Import Communications From Excel
Export Members To Excel
Export Communications To Excel
Update Number of Steps

5. Select Excel file and click OK. If you have more then one
worksheet in the Excel file with communications data,
then you will be prompted to select the worksheet to use.

Editing a Communication Circle
The communication circle may be edited directly in Visio
where you can change, add, or delete circle members. You
can also move, add, or delete Communication Paths.
Communication Paths can also be color coded to show
different types of communications (phone, fax, patient
initiated, etc.).
After making changes, use the “Update Number of Steps”
command in the right-mouse menu to update the number of
steps.
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Importing a Circle Members List
This is useful when the members are known but the
transactions are not. Use the “Import Members from Excel”
command in the right-mouse menu. The Excel data must be
in the following format:
MEMBER
Registration
Patient
Nurse
Unit Clerk
Physician

Y/N
Y
Y
Y
N
Y

The “Y/N” column is needed to specify members to import.

Communication Path Properties
Custom properties are available on the Circle Path shape
which may be used to capture additional details. To access
these, right-mouse click on a path, then select
“Shape>Custom Properties…".
Custom Propert...

SEQUENCE

4

DESCRIPTION

Send patient registration details to RN

DATE

3/27/07

TIME

5:06 PM

DISTANCE

Unknown

DURATION

Unknown

TYPE

Value Added

PATHWAY

Admission

The “Export Communications to Excel” command in the right
mouse menu of the circle will export all of the above
properties to Excel. The Communication Path line color is
also transferred to Excel.
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11. Creating A3 Reports
Help Movies
Create A3 Reports

eA3 comes with a template (below) of an A3 report and a set
of icons to make it easy to visualize the “Current Condition”
and “Desired State” aspects of the sheet. Click the A3 toolbar
button to create a new report.
eA3 Report

Zoom into the appropriate area and fill out the sheet.
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Diagramming the Current Condition

Insurance Impacts

a
Pr

c
ct i

No centralized
booking

Erratic OR Priority
Overrides

e

When to
Operate ?

Hospital

Hospital

A typical “Current Condition” diagram is shown above and
can be drawn very quickly in eA3 using the available icons.

Representing People

Healthcare
People

You can drag and drop a people shape from the stencil. You
can change a person’s “role” by clicking the right mouse
button and selecting the role (nurse, doctor, etc..). You can
also set a person’s expression in the same way. People
stacks are available for mfg, services and healthcare
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Representing Departments

Icon
Of
Place

Healthcare
Depts

High Roof
Place

You can create an iconic
representation of a department
by gluing an icon to its center.
Pharmacy You can also type in the name.

Pharmacy

a
Ph

The square frame of the dept
icon can be hidden with the right
mouse “framing” option for a
simpler look.

y
ac
rm

Glue point is here

Healthcare
Depts
Glue point is here

Low Roof
Place

Pharmacy

Healthcare
Depts
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Problems, Solutions and Callouts
Problem

Typically used to identify
problems

Kaizen
Starburst

Solution
Kaizen
Cloud
Text
Callout

Typically used to identify
solutions or positive attributes
of the “Desired State”

Typically used to denote
thoughts or verbal
communication

Icon Stacks

Healthcare
People

Mfg
People

Service
People

Mfg
Depts

Service
Depts

Healthcare Healthcare Transmit Transport
Items
Depts
Shapes
Shapes

Tables and Gadgets in A3 Reports
See the “Draw” and “Gadgets” sections to see how these
items can be used on an A3 Report.
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12. Using Gadgets to Visualize Data
Help Movies
Visualize with Gadgets

Any data on the map can be linked to visual gadgets that
change in size and color with change in the data. Some
gadget types are shown below:

Steps to Creating Gadgets
Each gadget has exactly one size parameter that can be tied
to a data value on the map. Here’s the typical means used to
apply and manipulate gadgets:
1. Drag out the gadget and position it
near the data value with which it will
be associated (in this case the
“Cycle Time”).

Process
Cycle Time

2

Mins

Bar Height
Gadget
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Steps to Creating Gadgets (Cont'd)
2. This system shape will be automatically dropped
on the page the first time a gadget is used. If
you copy a map to a new page make sure you
also copy this shape because it is used to hold
gadget data for the map.
Drag and glue the gadgets yellow
flying connector to the side of the
NVU data shape (avoid gluing to the
top or bottom of the data shape).

Gadget
Data

Process
Cycle Time

2

Mins

Right click on the gadget and use the
“Activate Gadget” option to create a
new gadget collection. The collection
name will be “Bar_Cycle Time”. The
name is created from the gadget type
and the data variable name.

3. A gadget can only belong to
one collection. Each collection
can only have a single type
(eg. “Bar”) of gadget.

Process
Cycle Time

2

Mins

You can change gadget scale
factors and color code them by
modifying the properties of the
associated Gadget Collection.
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Steps to Creating Gadgets (Cont'd)
4. You can easily create additional gadgets tied to other
instances of the same data on the map. Just click on the
gadget and use the right mouse button to select “Create
Gadgets By Example” to create the gadget for Process B
below.
Process A
Cycle Time

2

Process B
Mins

Cycle Time

2

Mins

5. Note that the new gadget is automatically positioned,
scaled and put into the same “Bar_Cycle Time” collection.
If you do not wish to have new gadgets created for the
whole map than select the original gadget, then sub-select
an area of the map before using the “Create Gadgets By
Example” menu.
Process A
Cycle Time

162

2

Process B
Mins

Cycle Time
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Mins
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Steps to Creating Gadgets (Cont'd)
6. You can update all the gadgets with changes to the
associated data values by clicking the Update Gadgets
button in the toolbar:
eVSM Update Gadgets
Process A
Cycle Time

2

Process B
Mins

Cycle Time 2.5 Mins

The diagram shows the impact of change from the data
values for the Cycle Time.
7. If a gadget fails to update its usually because it is unglued
from the data or has not yet been activated. Problem
gadgets can be highlighted using the “Gadgets Check On/
Off” button on the toolbar.
eVSM Gadgets Check On/Off
8. To modify a gadgets scale factor or to color code it you
need to change the properties of its associated collection.
Right mouse click on the gadget and select “Manage
Gadget Collections”
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Managing Gadget Collections
9. Gadget collections can also be accessed via the toolbar
button:
eVSM Manage Gadget Collections

Select a
collection from
the list and click
this button to
select/highlight
any gadgets on
the map that
belong to it

164

To transfer gadgets into a collection, first
pre-select them, then select the target
collection from the list and click this button.
A gadget can only belong to one collection
so it is removed from its existing collection
upon transfer
Also, a gadget can only be transferred to a
collection that has the right gadget type
(eg. “Bar”)
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Modifying and Color-Coding Gadgets

You can modify
the scale factor for
a collection that
controls gadget
size in relation to
data value. Use
the Apply button
to see the new
gadget sizes on
the map before
exiting the form.

165

To hide or show
gadgets in a
collection, first
select the
collection from a
list, then click this
button.
Note: the collection
list has a column
indicating visibility
status.

You can color
code the gadget
fill and font
colors based on
the value of the
data to which
the gadget is
glued. You can
also simply
“inherit” the color
from the data
shape or assign
a color to a
gadget
manually.
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Example: Cycle Time vs Takt Time

Cycle Time

Takt Time

Steps to draw the example above:
1. First make sure that the data you wish to visualize with
gadgets actually exists in eVSM data shapes.
2. Drag out a Bar Height Gadget, place it below the first
activity, and glue it’s flying connector to the Cycle Time
NVU for the first activity.
3. Set the bar’s fill color (blue in above example) and adjust
the bar width if you like.
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Example: Cycle Time vs Takt Time (Cont’d)
4. Click the Create Gadgets By
Example in the bar’s right mouse
button menu

Activate GadgetCreate
Gadgets By ExampleShow
Gadget CollectionManage
Gadget Collections

5. Drop a new Bar Height Gadget and attach it’s flying
connector to the NVU containing the Takt Time.
6. Align the new gadget with the first gadget collection, and
adjust it’s width to overlap the whole first collection. In
above example, color is set to yellow.
7. Activate the new gadget with the Activate Gadget
command in the right mouse menus.

8. Open the Manage Gadget Collections form, and make the
gadget scales for both collections the same via the
Modify… button
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Gadgets – Key Points
1. Gadgets have a single size parameter that will scale to the
data value in which a gadget is glued via the flying yellow
connector.
2. Gadgets are typically glued to NVU, VA or NVA shapes.
When gadgets in a collection are glued to data shapes
with different units, Units Converters are needed on the
map to compute the correct scale factors.
3. Gadgets have to belong to a collection. They can be put in
a collection using the Activate Gadget command or by
transferring them into a collection via the Manage Gadgets
form.
4. Gadget scale factors and color coding can be controlled
via the Manage Gadgets form.
5. An easy way to create a gadget “set” after creating a first
gadget is to use the Create Gadgets By Example in the
right mouse button menu.
6. The Visible switch on the Manage Gadgets form is very
useful in showing different metrics on the map in a
presentation environment.
7. See the “Examples” section on the eVSM help site
(www.evsm.com/help) for usage examples of the different
gadget types.
8. A starter set of gadgets is provided with eVSM. Additional
gadgets can be requested by contacting
support@evsm.com.
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13. Standardizing Value Stream Maps
Help Movies
These and other short movies on eVSM are available at
www.evsm.com/help
Work with Variables

Create Macro Shapes

Standardization Components
eVSM has built-in functions to allow your organization to
easily draw value stream maps using a standard that you
define. With standardization, maps can be drawn and
analyzed faster and can be understood by a wider group. The
standard comprises of the following:
Standard names for variables and units.
A Standard set of Macro Shapes (combinations of shapes)
that can make drawing maps faster.
Blank Starter Maps to ensure consistency and minimize
effort in starting new maps.
Company specific set of icons (eg. logo, name block, etc.)
to use when drawing maps.

170

13. Standardizing Value Stream Maps

170

Creating a New Standards (Visio Stencil) File
Components of standardization are delivered in a Visio Stencil
file. To create a new stencil file, click “File>Shapes>New
Stencil”.
This will open a new blank stencil. The stencil header bar
contains a right mouse button menu which allows you to
name the stencil (via the Properties command) and to save it
(it is a good idea to include a version number in the stencil
name). The stencil file should be saved in the “C:/Program
Files/eVSMStandards” folder. If this folder does not already
exist on your machine, then create it.
Copy/paste or drop shapes onto the stencil to populate it.
Name the icon and edit it’s bitmap with the right-mouse menu
options “Edit Master>Edit Icon Image”. Here is an example of
a standards file content
Corporate
Logo

Standard
Charts
171

New Drawing
Frame

Macro
Shapes

Standard Variable
and Unit Names
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Opening a Standards Stencil File
To open a Standards Stencil file from a drawing, click
“File > Shapes > Open Stencil…”
Then navigate to the folder below and select the *.vss file:
C:/Program Files/eVSMStandards
Note: A Visio drawing file “remembers” which stencil files
were open when you last saved it.
If you want new drawings to open with the Standards Stencil
already open, then follow these steps:
1. Start a new eVSM drawing by clicking the Start eVSM
icon on the Desktop
2. Open the Standards Stencil via “Files >Shapes >Open
Stencil…”
3. Click “File > Save As…”, change “Save as type” to
“Template (*.vst)”, and save the file in the “C:/Program
Files/eVSMStandards” folder.
4. Optionally, you can copy the saved *.vst file and paste a
shortcut for it on the Desktop and/or the Windows Start
menus. When the *.vst file or the shortcut is clicked, it will
start a new eVSM map with the standards file
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Managing Names & Units
The Name & Unit Manager (NUM) provides a simple way of
managing the names and units on a map via this toolbar
button.
eVSM Name and Unit Manager
The purpose of this management environment is to:
1. Provide a means to type in a name only once and then
use it consistently through out the map.
2. Provide a means to associate a default unit with a name
so that when a name is selected, the unit is automatically
set.
3. Provide a means of creating a starter set of names and
units for different application areas such as
manufacturing, healthcare, etc. This will allow a company
to create standard variable sets and deploy them easily.
The NUM function does not allow editing of names and units
directly in the data shapes. New names must first be added to
the NUM form. Then they can be accessed via right mouse
button menus on the following data shapes.
Name

Value Unit

Long NVU

Name
x.xx Unit

x.xx

Unit

Value Added

x.xx

Unit

Non Value
Added

Short NVU
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Managing Names & Units (Cont’d)
The NUM form is divided into three parts: Sets, Units, and
Names. Names and units visible in this dialog box represent
the Current Set. Only the Current Set names and units are
available on the right mouse button menu of datasets.
Saved
Sets

Current
Set Units

Current
Set Names
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Add New
Units

Current Set
Names
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Managing Names & Units (Cont’d)
Each name has a default unit. If a new name requires a new
unit, then the new unit must be created first.
The names and units seen in the NUM form are
available on the current page only and are stored
in the NUM shape.

Name
Unit
Data

The NUM shape can be copied to other pages or shared with
team members via a stencil.
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Name & Unit Sets
Sets are used to store collections of names and units.
The whole current set can be saved as a new saved set.
However, when a saved set is loaded into the current set, it
does not replace the current set, but adds to it.

Save To Set...
Saved Sets
eVSM Manufacturing
eVSM Healthcare
eVSM Services
MyNameUnitSet

Export Set...

Load From Set...

Excel

Import Set...

ft

yield (%)

secs
22.00

Data Data

rework (%)

secs days
A010 Build
xx
A020 Hand Cart
A030 Pack
xx

Data

distance

NVA Data

cycle time

VA

non value added

Operation

value added

Tag

%

%

5.00 96.00
135.00

xx

22.00

2.00 96.00

Saved sets can be imported/exported to Excel with the
“Import Set..” and “Export Set..” buttons.
To create your own set, just edit the current set so it contains
only items that you want. Then save this as a new set with the
“Save To Set” button.
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Name & Unit Sets (Cont’d)
You can also create a new set in Excel and then import it with
the “Import Set..” button.

Saved
Sets

The saved set can be used on other drawings and files by
exporting it to Excel and them importing the Excel file into
your target drawing.
You can edit the standardized list of names and units either
by export/import to Excel or via the “Modify Sets..” button.
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Delivery of Standardized Components
The team leader creating the company standard essentially
creates a collection of files that need to be copied to the
following folder on each team member’s machine:
“C:/Program Files/eVSMStandards”
Example files:
“acme.vss”
“acme.vst”
“readme.txt”

-

standards file (Visio stencil format)
new drawing startup file
can include version number, history,
any special instructions, etc.

A shortcut on the Desktop (or the Start menu) pointing to the
“acme.vst” file is useful for quick access to the standard.
The files can be delivered by manual means such as email,
CD, etc. For wider distribution, a setup.exe may be created to
automatically install the files in the correct location and create
a shortcut. One way of creating a setup.exe is shown at
www.evsm.com/v4/selfext.
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Standard Update Process
Steps to update and deploy the new standard:
1. Update Standard Files – team leader updates one or
more files.
2. Increment Version Number - in the stencil header bar.
Also update history in the readme.txt file.
3. Send to Team – rebuild installation kit, update
installation instructions, email or upload to server.
4. Install on Team Machines – verify update is not already
installed. Exit Visio and install new version.
The new standard is ready for use on new maps.

The “Load From Map” button will scan the current map for any
names/units which do not exist in the current set and add
them to the current set.

179

13. Standardizing Value Stream Maps

179

eVSM Macro Maker
eVSM Macro Maker allows you to create Macro Shapes.
Macro Shapes are made up of collections of commonly used
shapes. Macro Shapes can really speed up drawing of maps.
The eVSM Macro Maker button is in the eVSM toolbar and
replaces the “Macro Maker” shape which was in earlier
versions of eVSM.
eVSM Macro Maker
Create a new Stencil by clicking
on File (on the main Visio Menu
Bar) – Shapes – New Stencil

Any Stencil to which
changes are being made
must be in Edit Mode
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Steps to Create a New Macro Shape
1. From the main Visio Menu Bar click on
“File>Shapes>New Stencil” to create a new stencil, or
Right Click on an existing stencil and select Edit Stencil.
2. Select the shapes on the drawing page which you wish to
include in the new macro.
3. Make a copy of the shapes and drag the copied shapes
into the stencil.
4. Select the new Macro in the Stencil, then select the
shapes from step 2 and click the eVSM Macro Maker.
Select Yes when the message “OK to replace Shape
contents in Stencil: XXXXX”.
5. Name the Macro in the stencil by right clicking.
6. Edit the icon image if necessary via the icon’s rightmouse-button menu (“Edit Master > Edit Icon Image”).
7. Test the macro by dragging and dropping it onto a map.
8. If needed, make any changes that are required and
repeat steps 2 to 7.
9. Once your macro shape is ready, save the stencil.
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Steps to Edit an Existing Macro Shape
1. Open the stencil in which the macro resides and put the
stencil in edit mode (“Edit Stencil” command in right
mouse menus).
2. Drag and drop your macro shape from the stencil onto
the drawing page.
3. Make desired changes on the drawing page.
4. Select the updated shapes on the drawing page. Then
select the original macro shape in the stencil.
5. Click the eVSM Macro Maker button on the toolbar. This
will update the macro in the stencil.
6. Test the updated macro by dragging and dropping it onto
a map.
7. If needed, repeat steps 3-6.
8. Once your macro shape is ready, save the stencil.
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14. Analyzing with eVSM
Help Movies
These and other short movies on eVSM are available at
www.evsm.com/help:
Transfer Map Data to
Excel

Create Managed
Equations

Prepare for Analysis

Create Formulas directly
on the map

Working with Units

Fast Update

Multi-lane Processes

Perform Calculations in
Excel

The eVSM Calculator
Excel

22 Secs

135

ft

Cycle Time

22 Secs

Yield (%)

96

%

Yield (%)

96

%

Rework (%)

5

%

Rework (%)

2

%

xx Days
xx
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Secs

xx

Secs

eVSM
Calculator

secs days
A010 Build
xx
A020 Hand Cart
A030 Pack
xx
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Data

Data Data

yield (%)

Pack
Distance

NVA Data

rework (%)

Build
Cycle Time

VA

distance

Operation

A30

value added

A20

cycle time

Tag
A10

non value added

Visio

secs

ft

%

%

22.00

5.00 96.00
135.00

xx

22.00

2.00 96.00
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The eVSM Calculator (Cont'd)
The eVSM Calculator button in the toolbar provides bidirectional transfer of information between the map and a
spreadsheet. When the button is clicked for the first time in a
map, eVSM automatically creates a new Excel file and puts it
in the same folder the Visio file is saved in. The function only
operates on the current map page

Operation Tags

Operation
Tag
A10
Process

The Operation Tag shape is used to specify
which activities get synchronized with
Excel. The tag is glued to any glue-point on
the activity shape.
As new tags are dropped on the map, their
numbers will increment automatically. The
numbering sequence can be controlled via
the eVSM Tag Number button.
eVSM Tag Path Locator Defaults

Tag numbers can also be named manually. However, the
name must be unique and must be in the following format.
One
alphabetic
character

A123

Followed by
three numeric
values

Each tagged shape will generate a row in the spreadsheet.
Any data associated to that shape (via gluing) will appear in
that row. Excel rows are alphabetically sorted by tag number.
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Operation Tags (Cont'd)
A quick way to tag activities is to select them on the page and
in the sequence that you want them to be tagged. Then
simply click the eVSM AutoTag button.
eVSM AutoTag
The activities will be tagged starting with the tag number and
increment value as specified in the form under the eVSM Tag
Number Button.
eVSM Tag Path Locater Defaults
If you pick just a single existing tag and click the eVSM
AutoTag button then it will use the current tag value to reset
the form under the eVSM Tag Number Button. This is useful
because in addition to adding and numbering tags for the first
time, the eVSM Autotag button can also be used to renumber
a selected set of tags or activities.
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Excel Rowmaker Shapes
Only shapes with a grey corner in the stencil can be tagged.
These are called Excel rowmaker shapes since each of these
creates its own row in the spreadsheet.
Row shape examples:

Operation Transport
Shapes
Shapes

Outside
Source

Table

Transmit
Shapes

Common Calculator Problems
The eVSM Calculator has some requirements, if these are
violated, the calculator will stop, display an error message,
and in some cases, highlight the problem area on the map
with a red circle.
Missing Data: Data Shapes which are not properly
associated to Rowmaker Shapes (via gluing) will be missed in
the data transfer. The following button in the toolbar highlights
any data shapes which will be missed.
eVSM Excel Check On/Off
Missing Units Converter: If a variable is used with more
then one unit (eg. Cycle time in minutes and seconds), then a
units conversion factor must be provided. See the “Using
Units Converter” section on how the Units Converter Shape is
used to specify the conversion factor.
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Common Calculator Problems (Cont'd)
Duplicate or Unglued Tags: Each Operation Tag on the map
must have a unique value and must be glued to a valid Row
Shape.
Overlapping Data Shapes: Overlapping Data Shapes when
some are hidden behind others is not allowed.
Duplicate Data Shapes: Each Data Shape within a Row
Shape collection must have a unique variable name.
Grouped Shapes: eVSM Shapes should not be grouped. The
Calculator will abort if grouped shapes are found.

Data in Excel

Data columns sorted by
variable name

A010 Build
xx
A020 Hand Cart
A030 Pack
xx

Rows sorted
by Operation
Tag number
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Data Data
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Data
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NVA Data

cycle time

VA

non value added

One row per
Rowmaker Shape

Operation

value added

Tag
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ft

%

%

22.00

5.00 96.00
135.00
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22.00
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Calculations in Excel
Equations may be entered in the spreadsheet cells in which
Data Shapes are represented.
3

Steps:

Click the Enter button

2
Type “=” followed by
an equation

1
Select Cell

The next time the Calculator is run, the result of the equation
will be displayed in the appropriate data shape on the map.
The calculated value will be color coded red to show it is
controlled by Excel.
Note: After the “=” sign, instead of an equation (eg. =C3*D12),
static values (eg. =216) can also be entered. This allows entry
of measured metrics directly in the spreadsheet.
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Excel and Visio File Naming

eVSM Calculator

Map.vsd

Map.xls

When the eVSM Calculator is run for the first time, the Excel
file is created automatically and saved in the same folder as
the Visio file. The Excel file is given the same name as the
Visio file. A worksheet is created in Excel with the same name
as the Visio page.
Unit conversion variables in Excel are also scoped by the
page name.
eVSM relies greatly on the correspondence in names. Map
names should only be changed using the “Model Copy”
function

Fast Update
eVSM Fast Update
The Fast Update button in the toolbar allows spreadsheet
update 10x faster than running the eVSM Calculator. It is
active if changes after a calculator run are limited to formulas
and data values only.
The button is inactive (grayed out) when the spreadsheet is
out of sync with the map. It gets activated when the Calculator
is run.
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Numeric Formatting and Cell Fill Color
Raw data values are input in Visio and Formulas are input in
Excel. Results from Excel calculations are redisplayed on the
map in Visio.
The results of formula-based values are shown in Red in Visio
and Excel to distinguish them from raw data typed into Visio
Number formats set in Excel for formula-based cells are
inherited by Visio shapes. Colors of cells in Excel are
inherited by Visio shapes. Cell colors can be set directly or by
using Excel’s Conditional Formatting capability

Data Ranges
Data ranges (eg. Cycle time = 5-12 Secs) must be entered in
separate data shapes as shown below.

Build
Cycle Time 5-12 Secs

Build
Min Cycle
Time
Max Cycle
Time

5

Secs

12 Secs

Model Copy
eVSM Model Copy
The Model Copy button in the toolbar allows the map and
associated spreadsheet to be copied to a new page in the
same Visio file. This is very useful in copying an existing map
with calculations and then making modifications for “what-if”
studies or Future state possibilities.
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eVSM Equation Manager
All eVSM calculations are done via an integrated Excel
spreadsheet. The spreadsheet is created automatically when
the “eVSM Calculator” function is invoked. Results from
calculations in the spreadsheet are automatically displayed on
the map. eVSM supports two types of equations to perform
the calculations:
1. Direct Equations – formulas entered directly into cells in
Excel.
2. Managed Equations – equations managed by eVSM and
automatically inserted as formulas in Excel.
This section shows the Managed Equations capability in
eVSM.
Managed Equations are created in Visio and stored
in the NUM shape. When the eVSM Calculator is
run, they generate Direct Equations in Excel.
Visio

Excel

135

ft

Cycle Time

22 Secs

96

%

Yield (%)

96

%

Rework (%)

5

%

Rework (%)

2

%

eVSM
Calculator

xx Days
xx

Secs

xx

Secs

Managed Equations created
and stored in Visio
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Data Data

=($AE$18)*100/(($AF$18)*1440)
secs days secs
ft
%
A010 Build
xx
A020 Hand Cart
A030 Pack
xx

22.00

yield (%)

22 Secs

Yield (%)

Data

rework (%)

Pack
Distance

NVA Data

distance

Build
Cycle Time

VA

cycle time

Operation

A30

value added

A20

non value added

Tag
A10

Name
Unit
Data

%

5.00 96.00
135.00

xx

22.00

2.00 96.00

Direct Equations in
Excel
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eVSM Equation Manager (Cont’d)
The Equation Manager form is accessed through the Name
and Unit Manager
eVSM Name and Unit Manager

List of Managed
Equations

On/Off switch controls
whether or not equation
will be applied when
Calculator is run
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Creating Managed Equations
In this example, we will set up a Managed Equation to
calculate the Non-Value added (NVA) times associated with
inventory and daily demand. The equation is:
Inventory (Units)
Non Value Added (Days) =
Daily Demand (Units/Day)

Our goal is to use a single equation for the variable “Non
Value Added” that is applied everywhere on the map where
this variable exists. We will assume two key rules of the
Equation Manager:
There is only one equation for each target variable name
(left hand side of the equation).
An equation is either applied to the whole map (when it is
ON), or not applied at all (when it is OFF).

Steps
1. Click the New Eqn.. Button.
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Steps (Cont’d)
2. Enter a name and description
(optional) for the equation.
3. Select the variable name to calculate and
it’s corresponding units. This represents the
left hand side (LHS) of the equation.

4. Click Insert Variable for the right
hand side (RHS) of the equation.
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Steps (Cont’d)
5. Select “Parts” for
variable name and
units

6. Specify action to take if
variable is not found on map

7. Select the “ST” option. This specifies how data will
get selected from map. The selections are based on
Operation Tag and are explained further in the
following pages.
8. Click “OK” to return to the previous form.
196

14. Analyzing with eVSM

196

Steps (Cont’d)
9. Type “/” for the divide sign

10. Insert the next variable for the RHS. Here is the
resulting equation:
“ST(Parts;Unit;0;APPLY)/UV(Daily Demand;Unit;0;SKIP)”
To edit variables in the equation, place the cursor on the
variable and click the “Modify Variable..” Button.
11. To convert the Managed Equation into Direct
Equations, click the Calculator
button.
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Equation Manager Variables Options
Same as Target Tag (ST) – Used to select the RHS
variable from the same operation tag as the LHS variable.
Unique Variable On Map (UV) – Can be used when a
variable occurs only once on the map, so there is no need
to specify the operation tag id for it.
Named Tag (NT) – Allows you to provide a specific tag id.
Should be used sparingly because of dependency on fixed
tag id.
All Tags (ATS) - Selects the RHS variable from every tag
on map where it exists and makes a list to put in the Excel
function. Typical usage: sum all VA times.
Downstream Tags (DTS) – Selects the RHS variable from
the downstream tag as specified by the Tag Seq arrows
connecting the tags. Typical usage might be for cumulative
calculations starting downstream and moving upstream like
effective yield calculations.
Upstream Tags (UTS) - Selects the RHS variable from the
downstream tag as specified by the Tag Seq arrows
connecting the tags. Typical usage: cumulative time or cost
calculations.
Range of Tags (RTS) - Selects RHS variable from all tags
within the range provided. Typical usage: sum all times for
the A series tags in a swimlane chart.
List of Tags (LTS) - Selects RHS variable from all tags
supplied in a list
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Block Managed Equations
Each target variable (left hand side of equation) can be
driven by only one Managed Equation. When the
Calculator is run, the Managed Equation will be applied
to every instance of the target variable. Sometimes, you
may want to block the Managed Equation from being
applied to some instances of the target variable. This can
be done with the “Block Managed Equation” shape.

Block Mng
Equation

Yield

x.xx

x.xx %

Mins

Simply glue the “Block Manage Equation” shape to any
data shape which you want omitted from the Managed
Equations calculation.
Note: If the “Block Managed Equation” shape is attached
to a data shape AFTER it has already been calculated,
then you must manually delete its direct equation in
Excel before the next Calculator run, otherwise the OLD
equation will remain in the spreadsheet.
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Trace Value
The Trace Value function provides a means of seeing exactly
how a Managed Equation is being applied to a data shape.
Simply glue the Trace Value shape to the data shape you
wish to investigate. Run the eVSM Calculator, then click the
“Display Trace Data” command in the right mouse menu.
A005
Process A

Trace
Value

CT
Batch Size
CT per Unit

27
5
5.40

Min
Unit
Min
Display Trace Data
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Tag Sequence Arrow
The Tag Seq Arrow is used with Managed
Equations and allows you to perform upstream
downstream calculations.

Tag Seq
Arrow

The Tag Seq Arrow is glued to Operation Tags.

The example below shows how Accumulative Time can be
calculated along the value stream with the use of Tag Seq
Arrows.
A010

A030

A020

Process A

Process B

CT

15

Min

Accumulative
Time

15

Min

Transport
Time
Accumulative
Time

10

Min

CT

20

Min

25

Min

Accumulative
Time

45

Min

Managed Equation
Accumulated Time =
ST(CT;Min;0;APPLY)
+ ST(Transport Time;Min;0;APPLY)
+ UTS(ACCUMULATIVE TIME;MIN;0;APPLY;SUM)

The Tag Seq Arrow visibility can be set with the switch in the
eVSM Toolbar:
eVSM Tag Sequence Check On/Off
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Tag Sequence Arrow (Cont’d)
There are two ways to attach tag sequence arrows to tags.
The first is to drag out the arrow from the stencil and then glue
the two arrow ends to the tags.
The second method is to select a series of tags (or activities)
in the correct sequence and then click the eVSM AutoSeq
button in the toolbar
eVSM AutoSeq
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Path Locater
The Path Locater is used to identify a path that an activity (or
other tagable shape) belongs to. The shape is glued above
the top right corner of the shape.

Path Locater

Z060

4 1

Time Summary
A020 1

A010

Lead Time

2 1
A040

Stamping

1
Type

Inventory

xx

Ite
m

Total Value
Added
Value Added
Percent
Takt Time

Auto

Day

Auto

Min

Auto

%

Auto

Min

An activity can actually belong to none, one, or more paths. In
the example above, the “Stamping” activity belongs to path 1
and 2. Similarly, the Time Summary will show results for the
sum of Paths 1 and 4.
Path locaters can be glued to each other as long as at least
one of them is glued to the activity shape.
The benefit of assigning path numbers to activities is that the
associated activity variables (like NVA time) can be summed
up across the map in a path specific sense.
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Formula Wizard
eVSM Formula Wizard
This function provides an alternative method of creating Excel
formulas. The formulas are created in Visio by directly picking
items from the map. The Formula Wizard also has a
presentation function which highlights the participating data
shapes on the map and displays the formulas in readable
language.
The Formula Wizard is only active immediately after an
“eVSM Calculator” run. It is grayed out when inactive.

Using the Formula Wizard to create Excel equations
In the example below, we are going to set VA Time=Cycle
Time for the A10 activity.
A010
Process
Cycle Time

xx

22 Secs

Unit

1. First, pick the target shape representing the VA time.
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Using the Formula Wizard (Cont'd.)
2. Now click the Formula Wizard button in the toolbar.
3. The Formula Wizard text window shows the Excel cell
corresponding to the target shape (VA) that was selected.

4. Click the Insert Map Variable button to pick data on the
drawing for the the formula.
5. Pick the “Cycle Time”
NVU to create the right
hand side of the formula
A BLUE border on a shape represents
the right hand side of the equation.
A GREEN border on a shape
represents the left hand side of the
equation.
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Process
Cycle Time

xx

22 Secs

Unit
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Using the Formula Wizard (Cont'd.)
6. Here is the resulting formula. Click “OK” to send it to the
spreadsheet.

7. If the formula needs units converters than they are
available by clicking the “Show Units” button on the form.
Remember : The formula behaves exactly as if you typed
it into the Excel spreadsheet directly. So the units
corresponding to each data shape are those that the data
column has in Excel.
9. The “Formula Details” window shows the same formula in
a more readable language, useful for presentations.
Note: formulas cannot be edited in this window.
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Using the Formula Wizard (Cont'd.)

10. Use the Summation button to pick a value to be summed
across the map. For example, if you need the sum of the
VA times, just click the summation button, then select any
one VA time shape on the map. eVSM will automatically
find all the VA time shapes.
11. If the Formula Wizard Icon is grayed out, it is because the
spreadsheet needs to be updated first. Do this by running
the eVSM calculator.
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15. Working with Tables
Help Movies
These and other short movies on eVSM are available at
www.evsm.com/help:
Draw Tables

Draw Swimlane Charts

Purpose
The eVSM Table shape was introduced to allow easy creation
of box-score tables on the map.

Starter Table

Table

This is a simple starter table that can be further
customized:
Select Table
View Row and Column Size
Adjusters
Adjust Table
Clone Row Below
Clone Row Above
Delete Row
Use as Standard Row Height
Clone Column on Right
Clone Column on Left
Delete Column
Use as Standard Column Width

A right mouse click on any of the table cells brings up a
table modification menu (above) allowing for row / column
addition and modification.
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Resizing Rows and Columns
Pick the “Select Table” command in the
right mouse menu to highlight the yellow
diamonds. Move these yellow diamonds
to the required width and height
positions. Then click the “Adjust Table”
command in the right mouse menu.

Editing Text
Double-Click on a table cell to change its text.

Moving the Table
To move the table to a new position on the map, click the
“Select Table” command in the right mouse menu. Then drag
the table to the desired location.
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Swimlane

Lane B Lane A

Swim Lane Table

The eVSM Swimlane function allows drawing of VSMs and
flowcharts in swimlane layout. The eVSM Swimlane shape is
an implementation of the eVSM Table function. Therefore,
row manipulation and resizing works exactly as shown above
for the Table function.
To calculate totals or plot charts for each lane, see the Path
Locator function.
Note: The swim lane function in native Visio is NOT supported
with eVSM. The eVSM Calculator will not work if the Visio
swim lane shape is on your drawing page.
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Tables and Spreadsheets
You can transfer table cell data to the spreadsheet with the
“eVSM Calculator” button
eVSM Calculator
To transfer the data the table has to be tagged first.

Operation
Tag
A10
Current State

Future State

Lead Time

23 days

2 days

Capacity

1057

2000

Each table creates its own worksheet page in the Excel
Workbook. If the page name is “CS” and the tag is “A10” then
the worksheet in Excel will be called “CS_A10”. If formulas
are created within cells in the spreadsheet, the results of
those formulas will appear in the table when the eVSM
Calculator button is clicked.
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16. Plotting VSM Charts
Help Movies
These and other short movies on eVSM are available at
www.evsm.com/help:
Draw Combination
and Pareto Charts

Draw Milestone
Charts

Draw Cumulative Bar
Charts

Draw Ladder Charts

XY Charts (Combination and Pareto Charts)

Secs

Any numeric data available for analysis in eVSM can be
plotted on a chart such as this:

ACME Scissors
B20

Current State

Plant Summary
No of Shifts
2.00 Shifts
per Day
No of Work
5.00 Days
Days per Wk
Production Hrs
15.00 Hrs
per Day
Defects

500.00 ppm

Raw Materials 62.50
Wks

Days

Shifts

Hrs

Mins

5

2

7.5

60

60

Finished
Goods
Work in
Progress

Days

Shifts

Hrs

Mins

Secs

Takt Time

Hrs

4.17

Hrs

86.25

Hrs

67

Secs

80
70
60
50
40
30
20
10
0

Cycle Time - Takt Time Chart

Chart
Maker

Takt Time
Cycle Time

Production
Control

Daily

A010 A020 A030 A040 A050
Weekly Order

Forecast 30 Days

MRP

D

Cross Dock

ol
d

Weekly Schedule

Daily Demand 18000 Pairs

1

Daily Ship Schedule
Frequency

M

Frequency
Per
Week

A10

A20

Mold Handles

Scissors

Cycle Time

53

75000 Pairs

Changeover
Time
Operators
Batch Size

1

A30

A40

Sharpen

Secs

Scissors

Cycle Time

75

2

Hrs

38500 Pairs

Changeover
Time

2

Staff

Operators

50

Pairs

Batch Size

Drill

Secs

Scissors

15

Hrs

27000 Pairs

1

Staff

50

Pairs

Cycle Time

A50

Assemble

20

Secs

Scissors
31000 Pairs

Operators

1

Staff

Batch Size

50

Pairs

Te
st

ril
l
As
se
m
bl
e

A70

H

ATLAS
Warehouse

an
dl
es
Sh
ar
pe
n

Daily

Cycle Time

30

Test

Secs

Operators

1

Staff

Batch Size

50

Pairs

Scissors
7000

Pairs

Per
Week

A60

Cycle Time

Ship

10

Secs

Operators

1

Staff

Batch Size

50

Pairs

Scissors
5000

Defects

500

ppm

Pairs

B10

Summary
4.17 Days

2.14 Days
130.00 Secs
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1.50 Days
75.00 Secs

1.72 Days
20.00 Secs

0.39 Days
30.00 Secs

0.28 Days
10.00 Secs

Production
Lead Time
Processing
Time

10.19 Days
265.00 Secs
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XY Charts (Cont’d)
Before creating a chart, you must ensure that the data to be
plotted is:
- Contained in eVSM data shapes
- The data shapes are glued to the parent rowmaker shapes
- Rowmaker shapes are tagged with Operation Tags
Hint: Use the Glue Check and Excel Check buttons in the
eVSM toolbar to verify.

Steps to Plot XY Charts
1. Drag out the XY Chart icon from the stencil, and place it
anywhere on the map.

XY Chart
XY
Chart
Edit Chart DataPlot
ChartCreate
Spreadsheet

Right mouse click on the shape and select the “Edit Chart
Data” command.
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Steps to Plot XY Charts (Cont’d)
2. Set up chart parameters and click “Plot Chart” command in
the right mouse button menu.
Enter chart title
Set data filters

Select Y-axis units

Select data
variables (eg.
Cycle Time) to plot

Optional chart
description

216

Variables will be plotted in
sequence shown here. Use Up
Down buttons to change sequence
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Steps to Plot XY Charts (Cont’d)
Options for Chart Variables:
Set a default value for nonexistent plot points
Select Variables to plot
Select Display Type

Enter Tag number for single tag
data plot
Set color of Fill or lines

3. Click the Plot Chart command in
the right mouse button menu.

Edit Chart DataPlot
ChartCreate
Spreadsheet

Notes:
Each eVSM Chart is a group of simple shapes. Avoid
ungrouping these as this may displace some of the shapes.
Chart will update automatically when the Calculator or Fast
Update is run. To update the chart manually, use the
“Update command in” the Chart’s right mouse button menu.
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Milestone Charts
The Milestone Chart allows you to plot key milestones on a
combined timeline.

Steps to Plot a Milestone Chart
1. Get data ready in this format:

C180

C190

Sales Milestones

218

Manufacturing
Milestones

Order Approved

90

Days

Manufacturing
Begins

80

Days

Order Shipped
to Customer

10

Days

Inspection
Complete

30

Days

Order Accepted

0

Days

Manufacturing
Complete

15

Days
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Steps to Plot a Milestone Chart (Cont’d)
2. Drag out the Milestone Chart icon and click the “Edit”
command in it’s right mouse button menu.
Milestone
Chart

Milestone
Chart

Edit Milestone Chart
DataPlot Milestone
ChartCreate Spreadsheet

3. Complete the form:

4. Plot chart
Milestone
Chart
Edit Milestone Chart
DataPlot Milestone
ChartCreate Spreadsheet

Update Milestone Tag Chart

5. Use the “Update..” command in the chart’s right mouse
button menu to update the chart when the data changes.
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Cumulative Bar Charts
The Cumulative Bar Chart allows you to visualize the phases
of a value stream on a timeline.

Steps to Plot a Cumulative Bar Chart
1. Get data ready in this format:

B070
Order Fulfillment
Timeline
Process Order

1

Days

Order Approval

8

Days

Scheduling

3

Days

Wait for Mfg

15

Days

Manufacturing

10

Days

Wait for
Delivery

1

Days

Delivery

2

Days

2. Drag out the Cumulative Bar Chart icon and click the “Edit”
command in its right mouse button menu.
Cumulative
Bar Chart

Cumulative
Bar Chart
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Edit Milestone Chart
DataPlot Milestone
ChartCreate Spreadsheet
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Steps to Plot a Cumulative Bar Chart (Cont’d)
3. Complete the form:

4. Plot the chart:
Edit Milestone Chart
DataPlot Milestone
ChartCreate Spreadsheet

Update Cumulative Tag Chart

5. The chart will update automatically when the Calculator or
Fast Update is run. To update the chart manually, use the
Update command in the Chart’s right mouse button menu.
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Ladder Charts
The Ladder Chart shape allows you to create timeline and
operator balance charts such as the following:
Value Added and Non-value added Time Ladder
0

5

10

15

A010De-A020Asse
burr
mble
Casting Lining

20

A030Insta
ll switch

25

30

Min

35

A040Sold
er Wiring

Non Value Added

Value Added

Operator Balance Chart
0

2

4

6

Min
8 10 12 14 16

Operator1
A010De-burr A020Assembl
Casting
e Lining
Operator2
A030Install
switch
Operator3
A040Solder
Wiring

222

16. Plotting VSM Charts

222

Steps to Plot a Timeline Ladder Chart
We will plot a Timeline Ladder for the VA/NVA times from this
VSM.
A010

A020

De-burr Casting

Operator1

3

A030

Assemble Lining

Min

1 Min

Operator1

12

Min

3 Min
2 Min

A040

Install switch

Operator2

7

Solder Wiring

Min

3 Min
9 Min

Operator3

13

Min

4 Min
4 Min

9 Min

1. Drag out the Ladder Chart icon and click the “Edit”
command in it’s right mouse button menu.
Ladder
Chart

Ladder
Chart

Edit Ladder Chart
DataPlot Ladder
ChartCreate Spreadsheet

2. Complete the form:
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Steps to Plot a Timeline Ladder Chart (Cont’d)
3. Plot chart
Ladder
Chart

Edit Ladder Chart
DataPlot Ladder
ChartCreate Spreadsheet

Value Added and Non-value added Time Ladder
0

5

A010
A020
De-burr Assemble
Casting Lining

10

15

20

A030
Install
switch

25

30

Min

35

A040
Solder
Wiring

Non Value Added

Value Added

Update Chart

4. The chart will update automatically when the Calculator or
Fast Update is run. To update the chart, manually, use the
“Update Chart” command in the chart’s right mouse button
menu.
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Steps to Plot an Operator Balance Chart
Here is our data:
A010

A020

De-burr Casting

Operator1

3

A030

Assemble Lining

Min

1 Min

Operator1

12

Min

3 Min
2 Min

A040

Install switch

Operator2

7

Solder Wiring

Min

3 Min
9 Min

Operator3

13

Min

4 Min
4 Min

9 Min

1. Drag out the Ladder Chart icon and click the Edit
command in it’s right mouse button menus
Ladder
Chart

Ladder
Chart

Edit Ladder Chart
DataPlot Ladder
ChartCreate Spreadsheet

2. Complete form
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Steps to Plot an Operator Balance Chart (Cont’d)
3. Plot the chart:
Ladder
Chart

Edit Ladder Chart
DataPlot Ladder
ChartCreate Spreadsheet

Operator Balance Chart
0

2

4

Min
8 10 12 14 16

6

Operator1
A010
De-burr
Casting

A020
Assemble
Lining

Operator2
A030
Install switch
Operator3
A040
Solder Wiring

Update Chart

4. The chart will update automatically when the Calculator or
Fast Update is run. To update the chart, manually, use the
“Update Chart” command in the chart’s right mouse button
menu.
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Filtering data that is plotted on a Chart
The forms associated with each chart provide some filtering of
the activities that contribute data to these charts primarily via
the tag prefix, its number, and its color.
In addition, the XY Chart and the Ladder chart allow activity
data to be used only from activities on given paths (as
specified by gluing path locaters on those activities).
To filter in this way simply glue the path filter shape(s) onto
the bottom right corner of the chart box as shown below

XY Chart

Ladder Chart

XY
Chart

Ladder
Chart

1

Path Filter

1 2

In the case of the ladder chart above, data is taken from any
activity that is on EITHER path 1 or path 2. If no path filters
are glued onto the chart boxes then data is taken from all
activities.
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17. Stencil Maker
What is Stencil Maker ?
Create your own customized Stencils using shapes either
from one of the existing Quick Stencils of build one from
scratch.

Customized Stencil

You can name your
own stencil and
distribute it.

Have as few or as
many shapes as you
need in your stencil.
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Can My Stencil be used on existing maps ?
You can only use your stencil for completely NEW maps. The
stencil relies on a standard set of names, units and eqn’s that
old maps will not be compliant to.

Quick Maker Stencil
Open the Quick Maker Stencil from the File Menu:
File – Shapes – Open Stencil (and navigating to: C:\Program
Files\GumshoeKI\Visio2002\Setup\Solutions) and selecting
QuickMaker.vss
Used to enclose and
identify an entire
macro shape

Comment for macro
shape Help

Warnings and Tips on
using the macro shape
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Create your new stencil
Create a new Stencil by selecting New Stencil from the file
menu.

When you create a new stencil it will be in edit mode. Right
click on the stencil header and open the properties dialog box
to name you stencil in the Title field.
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Create Icons in the new stencil
Populate your stencil with icons by copying an icon from an
existing stencil and pasting it in your new stencil.
The Icon in a Stencil is called a Master. You can rename the
Master and Change its Image by right clicking on the the
Master. Editing the Image opens up a bitmap editor in Visio.

Copied from an
existing stencil
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Design Page
The most important piece in Stencil creation will be the
Design page. This is where you will create the shapes that go
into your stencil. It is also where you will create help for your
shapes. Any changes that need to made to a stencil should
be done here and then regenerating the Stencil from the
Design Page.

Design Page for My Stencil

There are two ways to create the shapes for your stencil: 1)
By using shapes from one of the Quick Stencils (but you
cannot mix shapes from different stencils), or 2) Using base
eVSM to build all your shapes from scratch.
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Design Page – Cont’d
Create a Design Page for the New Stencil. On a new
page create the macro shapes for the stencil, use the
Macro Enclosure from the Quick Maker Stencil and place
it around your new macro shape. Resize as necessary,
but leave enough room to place the Icon Image in the
Macro Enclosure as well. Use the Yellow call-outs to
write help text for the Macro.

Macro Enclosure

Mfg
Data
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TemplateMaker Toolbar

Open the eVSM Templatemaker Toolbar :
Tools> Macros> eVSM Icons >
eVSMTemplateMaker>CreateTemplateMakerToolbar.

Icon Maker
eVSM Macro
Maker 3
The Template Maker Toolbar consists of two buttons:
eVSM Macro Maker 3 – Used to generate a stencil from
the design page
Icon Maker – used to generate Icons for shapes
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TemplateMaker Toolbar - Cont’d
Select an Icon from your Stencil that belongs to the Macro
Shape you are working on. Make sure nothing on your design
page is selected. Then click on the Icon Maker in the
Developer Toolbar. This will make a copy of the Icon and
place it on your design page. Put it in the Macro Enclosure for
the appropriate macro.

Icon Maker
Manufacturing Data
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Generating your Stencil

eVSM Macro Maker 3
Once your design page is complete, simply select any one
Icon in your new Stencil then click on the eVSM Macro Maker
3 Icon in the Developer Toolbar. You will be prompted that
your are replacing (no. of masters) in the Stencil. Click ok and
your masters in the Stencil will be replaced with the ones on
your design page.
All changes to the Stencil MUST be made through the design
page. This will ensure stability. You can now save the Stencil
and deploy it by simply sending them the Stencil file (.vss).
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Creating Help for your shapes
Create contextual help for your shapes by using the Macro
Comment call out from the Quick Maker stencil.

Macro Comment

When a user selects an Icon in the Stencil then Clicks the iQ
button in the toolbar, an exact image of the Macro from the
Design page is placed on the map with the help text that you
included in it’s enclosure.
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18. Managing Improvements
Help Movies
Annotate Problems/Ideas for Kaizens

Create Model Copy for Editing

Map Annotation with Kaizen Bursts & Clouds
123

Problems can be
documented using
Kaizen bursts

Problem

Kaizen
Starburst

Solutions can be
suggested using
Kaizen clouds

123

Kaizen
Cloud

Solution

Adding Attributes to Kaizen Shapes
Additional attributes can be added to Kaizen Bursts and
Clouds by selecting the shape with a right mouse click
and picking the “View Custom Properties” menu.

Kaizen

238

Export to ExcelView Custom
Properties
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Generating Kaizen Reports
eVSM Kaizen Report
The eVSM Kaizen Report toolbar button scans the map for all
Kaizen shapes (Starbursts and Clouds) and exports custom
properties associated with the shapes to two Excel
spreadsheets (Pagename_Starbursts and
Pagename_Clouds).
The standard custom property user interface in Visio allows
Lean Practitioners or organizations to define their own custom
properties for export.
Cu...

Sequence

3

Problem

Problem Description

Owner

Joe Bloggs

This functionality allows export to Excel and via Excel to other
products like Microsoft Project Manager. The function
replaces the Visio-based Kaizen Table in earlier releases.
Note that the Kaizen Report export is unidirectional and a new
report is generated every time overwriting any existing report.
Version 5.29 and later of eVSM include “Impact” and
“Difficulty” custom properties that can be used to plot a Kaizen
Impact Matrix
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Plotting a Kaizen Impact Matrix

Kaizen Impact
Matrix

Plot Kaizen Impact Matrix

Kaizen
Impact
Matrix

The Kaizen impact matrix was introduced in eVSM V5.29 and
uses the “Impact” (Impact On Value) and “Difficulty” (Difficulty
of Implementation”) custom properties of kaizen burst and
clouds to plot an impact matrix as shown on the next page.
The goal of the matrix is to help select kaizens for
implementation.
The mini-kaizens in the matrix copy the custom properties of
the originals (map kaizens) so its useful to have the custom
properties window (View > Custom Properties Window) open
while selecting these shapes. They are numbered based on
the ID’s of the Kaizens on the map (ID’s are circles glued to
the top left of the kaizen shapes). A Right mouse click on any
of the mini-kaizens allows for selection and highlighting of the
parent map kaizen.
Highlight Kaizen

6

If map kaizens are modified than the Impact matrix can be
updated by selecting it with a right mouse click and the
command “Update Chart”.
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Making a Model Copy
eVSM Model Copy
This function creates a duplicate of the whole VSM model. A
VSM model consists of the map and the associated Excel
worksheet. It is generally used when a duplicate map is
necessary for “what-if” studies and for creating future state
versions.
This is also the preferred method of effectively renaming a
page.
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19. Sharing with eVSM
Copy and Paste into PowerPoint or Excel
Visio shapes can simply be selected, copied and then
pasted into other Microsoft office applications like
PowerPoint and Excel. Be sure to paste a picture using the
Paste As… command. This will allow re-sizing of the pasted
picture without requiring editing and font adjustments.

Visio Viewer
A free Visio Viewer is available for download at:
http://www.microsoft.com/downloads

Acrobat PDF
Acrobat PDF allows capture of any size drawing in a single
file, which can be viewed with the free Acrobat Reader, and
is easily printable. On-screen viewing is good, it is
searchable, and supports password security. The author
must have the Acrobat Distiller software, the audience only
need the free Acrobat Reader. Steps to convert an eVSM
map to PDF:
1. Click the “File>Print…” menu.
2. Select Acrobat Distiller as your Printer, and click “OK”.
3. You will then be prompted for the PDF file name and the
location to save the PDF file in.
242

19. Sharing with eVSM

242

Publish to Web
eVSM maps can be converted to web format which can be
viewed in any web browser. The web format files can be
uploaded to a web server or emailed.
Steps to convert to web format:
1. Click “File>Save as Web Page…”.
2. In the “Save As” dialog. Click, the “Publish…” button.
3. In the “Publish” dialog, click the “Format Options…”
button, set format to “GIF”, and click “OK”.
4. To later view this in a web browser, just open the html
file with the same name as your eVSM filename in a
web browser.
5. The conversion to web format creates a collection of
web files. All of these need to be included in any email
transfers or upload to a web server.
6. To open the drawing in a browser, click the
drawing_name.htm file.

Convert to Bitmap
Common bitmap formats such as JPEG, GIF, and TIFF can
be viewed in most browsers without any additional software.
eVSM maps can be converted to these and other graphic
formats from the “File>Save As…” menu. In the “Save As”
dialog, click the “Save as type” pull-down and select the
format.
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Printing
Visio allows drawings of any size. The drawings can then
be printed on any size paper supported and available on the
printer.
When the drawing size does not match the paper size, you
can either print across several sheets, or shrink (or expand)
the drawing to fit the paper by clicking “File>Page Setup…”
and then checking the “Fit to 1 sheet” radio button.
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Print (Cont’d)
The “File>Print Preview” function can and should be used to
assess the print output before committing the drawing to
paper.

Printing Problems
The eVSM Software essentially generates a Visio file. The
printing of the file is handled by standard Visio functionality.
Problems printing from Visio could be due to Visio, the print
driver, or the printer.
Here are some suggestions if you have problems printing
from Visio:
Make sure you have the latest Visio Service Patch
installed
Try copy/pasting your VSM to PowerPoint or Excel and
then print from there
Convert your VSM to Acrobat PDF and then print the
PDF file

245

19. Sharing with eVSM

245

Toolbar Button Index
Communications Circle

153

eA3 Report

156

eVSM Autofix

140

eVSM AutoPath

112 ,128

eVSM AutoSeq

202

eVSM AutoTag

186

eVSM Calculator

190 ,213

eVSM Drill Down

142

eVSM Excel Check On/Off

187

eVSM Fast Update

190

eVSM Formula Wizard

206

eVSM Gadgets Check On/Off

163

eVSM Glue Check On/Off

10

eVSM Kaizen Report

239

eVSM Link Activities

139

eVSM Macro Maker

180

eVSM Manage Gadget Collections

164

eVSM Model Copy
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Toolbar Button Index

191 ,241
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Toolbar Button Index (cont'd.)
eVSM Name and Unit Manager

29 ,133 ,173 ,193

eVSM Tag Path Locater Defaults

112 ,128 ,186

eVSM Tag Path Locator Defaults

185

eVSM Tag Sequence Check On/Off

201

eVSM Unlink Activities

139

eVSM Update Gadgets

163

eVSM v5 Migration

142
41 ,91

Quick eVSM
Spaghetti Diagram

247

Toolbar Button Index

149
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Icons Index
17 ,47 ,71 ,99 ,115

Activity Assc Time

33 ,39 ,60

Activity Center

30 ,60 ,81

Activity Changeover

33

Activity CT Range

83

Activity Defects

37 ,61

Activity Demand

32 ,33 ,61 ,82 ,83

Activity Demand %

33 ,61 ,83 ,87

Activity Downtime

33 ,61

Activity Efficiency

83

Activity NVA

34 ,62

Activity OEE

34

Activity Rolling Defects
Activity Rolling Time

62 ,83 ,89

Activity Scrap

33

Activity Shortage

34

Activity Stations
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36 ,37

34 ,62 ,82

Icons Index
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Icons Index (cont'd.)
Activity Time

34 ,62 ,83

Assoc. Load Chart

39

Bar Height Gadget

160

Block Mng Equation

199

Callout

159

CT / TT Chart

42 ,66 ,92

Cumulative Bar Chart
Curvable Arrows

31 ,113 ,129

Customer Center

25 ,55

Decision Center

59 ,86

Decision Rolling Time

59

Downtime

32

Electronic Info Flow
FIFO Arrow

31 ,84 ,113 ,129
31 ,113 ,129

Finished Goods

31 ,113 ,129 ,136

Healthcare Data

78

Healthcare Depts

249
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158 ,159

Icons Index
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Icon Index (Contd.)
Healthcare Items

159

Healthcare People

157 ,159

High Roof Place

158

Icon Of Place

158

Inventory Center

27

Inventory Demand

28

Inventory Demand %

28

Inventory Rolling Defects
Inventory Shapes

135

Inventory Value

27

Kaizen Cloud

159 ,238

Kaizen Impact Matrix
Kaizen Starburst

240
159 ,238

Key Creator

68 ,96 ,143

Ladder Chart

223 ,225 ,227

Lead Time Chart

67 ,93

Long NVU

250

34 ,36

134

Icons Index

250

Icon Index (Contd.)
Low Roof Place

158

Macro Comment

237

Macro Enclosure

233

Manufacturing Data

25 ,235

MCT Data

107 ,123

MCT FG

108 ,124

MCT Map

128

MCT Summary

106 ,122

MCT Supply

110 ,126

Mfg Activity

111 ,127

Mfg Depts

159

Mfg People

159

Mfg Wait

111 ,127

Mfg WIP

104 ,106 ,111 ,120 ,122 ,127

Milestone Chart

219

Non Value Added

134

NVA Timeline Chart

251

Icons Index

43

251

Icon Index (Contd.)
Operation Shapes

131

Operation Tag

185 ,213

Outside Center

26 ,56

Outside Source

130

Path Filter

227

Path Locater

86 ,203

Patient Center

78

Plan Activity

109 ,125

Plan Wait

109 ,125

Query Center

63 ,85

Query Rolling Time

252

63

Queue Center

56 ,80

Queue Demand

57 ,80

Queue Demand %

57 ,80

Queue Rolling Time

57

Quick HC Info

96

Quick Mfg Info

44

Icons Index

252

Icon Index (Contd.)
Quick Svc Info

68

Rolling Time

89

Service Depts

159

Service People

159

Services Data

55

Short NVU

135

SM Activity

110

SM Wait

110

Spaghetti Place

149

Spaghetti Scale

149

Staff Summary

40 ,65

Start eVSM

4

Stepped Arrows

31 ,113 ,129 ,131

Supermarket

135

Swimlane

212

Swimlane Frame

66

Table

253

210

Icons Index

253

Icon Index (Contd.)
Tag Seq Arrow

37 ,84 ,89 ,201

Time Center

25 ,55 ,78 ,107 ,123

Time Summary

24 ,41 ,54 ,65 ,88 ,91

Trace Value

200

Transmit Center

35 ,52 ,64 ,90

Transmit Rolling Time
Transmit Shapes

84 ,136 ,137 ,159

Transport Center

22 ,35 ,76 ,90

Transport Shapes

136 ,159

Units Converter

29 ,137

VA / TT Chart

43

Value Added

254

64

134

Var Key Creator

68 ,96

Wait Center

58 ,79

Wait Range

79

Wait Rolling Defects

36

Wait Rolling Time

58

Icons Index

254

Icon Index (Contd.)
White/Gray Map

112

XY Chart

255

215 ,227

Icons Index

255

General Index
A
activity center
arrows
automove
autoseq
autotag

E
139

enable macros
equation manager
evsm calculator

202

F

186

fast update
file naming
fill color
flying connectors
formula wizard

30 ,60 ,81
131

B
243
bitmap
block managed equations199
9
blue icons
135
buffers

C
calculator problems
cell color
chart maker
chart variables
communication circles
cumulative bar charts
current set

187
191
214
217
152
220
174

D
data
data link
data ranges
decision
decision center
direct equations
drag & drop
drill-down
256

gadget collections
gadget color-coding
gadget hide/show
gadget scale factor
gadgets
gadgets by example
gadgets check
glue
grid

H

144

help site

191

I

59
192
9
142

192 ,193
185
190
190
191
134
206

G

132

86

4

icon colors
inventory
inventory data

164
165
165
165
160
168
163
10 ,74
9
5
71
135
135

K
kaizen

General Index

238

256

General Index (cont'd.)
kaizen cloud
kaizen impact matrix
kaizen starburst
key creator

159

operation tags
operator balance chart
outside center

143

P

159
240

L
222
ladder charts
6
lean enterprise academy
6
lean enterprise institute
6
lean healthcare west

M
180
macro maker
170
macro shapes
72
main stencil
228
maker
192
managed equations
managing improvements 238
142
migrate maps
218
milestone charts
191 ,241
model copy
138
multi-unit edit

N
name & unit sets
non value added
number format
numeric format
nva

176
134
191
191
134

O
operation tag
257

page resizing
pareto chart
path filter
path locater
pdf
people
pid
plot charts
plot xy charts
powerpoint
printing
printing problems

185
225
56
8
214
227

24 ,203
242
157
78 ,80
214
215
242
244
245

Q
query center
queue
queue center
quick evsm
quick hc
quick maker
quick mct
quick mctlite
quick stencil

63
135
56
16 ,46 ,70
70
229
114
98
73

R
76 ,185

resizing shapes

General Index

9

257

General Index (Contd.)
rolling defects section
rolling time
rowmaker shapes

34

transport

83

U

187

S
security setting
snap
snap to grid
spaghetti diagram
spaghetti place
spaghetti report
spaghetti scale
standard names
standardization
starter maps
stencil
supermarkets
support
swim lane

unit converters
unit family

4

V

9

149

va
value added
visio pages
visio viewer

148

W

149
170

wait center
web

170

X

170

xy charts

9
148

7 ,228
135

136
137
137
134
134
12
242
58
243
214

Z
zoom

13

5
212

T
tag seq arrow
tag sequence arrow
templatemaker toolbar
text editing
time summary
timeline ladder chart
toolbar
trace value
transmit
258

201
201
234
11
88
223
5
200
136

General Index

258

General Index (Contd.)

259

General Index

259

Useful URL’s
eVSM Demonstration

http://www.evsm.com/demo

Download Trial

http://www.evsm.com/trial

Check for Latest Updates http://www.evsm.com/updates
eVSM On-line Help

http://www.evsm.com/help

eVSM Installation Help

http://www.evsm.com/install

eVSM Training

http://www.evsm.com/training

Transfer eVSM to new PC http://www.evsm.com/transfer
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